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1. fi9

MEERERAOLRATTHFAORR BB TL-EERMELE
AMRMZB R LZHEREMWY - AMMAEBRTHEBENLETFHHF
REHECHTHERETH - FRAFRERTE/RRTBRIELAME
BHEBER H— L AEITLBARAYZEHRFINELEEMNLE > b
Secure Socket Layer (SSL)/Transport Layer Security (TLS) #} & -
Internet Protocol Security Protocol (IPSec) - Secure Electronic
Transaction (SET) % + £ ¥ £ P 3% ~ FARM® &9 RABHH] £ XA
SSL/TLS$2IPSec % iy K £ °
R IPSec X B AT #t Ao A BB (VPN)# £ R M F - 2R a7
BATEBAA @R — LS FRH D RAGRBAAL  Hhv LIPSec
R EHEAOSIEA gy R > B b FEBRIE#](Access Control) k> &
R A3 GBIE e KR EEHFRIER KR - B8 TFSSL/TLS &
AAEFVELOSIHMA FTeHARBZ LARABZTHHT > BET
DRBAE R E SR AR ERREX AR - wEREZ  HRX
B REEAERIE R 69k > Bw ESSL/TLS S BE Al £ @ R
FIMBEHRLENRZELHTIPS) RABEZH X EEANE
SSL/TLS% & » 4£43SSL/TLS R A A % -
B A7 % & SSL/TLS & X & & % % % &) 3% & OpenSSL 3t £ -
OpenSSL3t & & /&4 8 42 X, 2% 3t 5 Eric Young#r % & #SSLeay & 2,
Bk Ra—#HERLAFRRGERLMARGER 8 AR
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- # A RSSL/TLS& X B » T AMMAENRBAERERRAHLHE
BEHE—EERAE EFTATTURTREXELRR 2 KX BEAE4T
AR R RABERAFTE SN A MAESER X ERIE
fTAMER » BISbIR 4538 EOAR P 3%~ IR A A BNW T 3#
%o : TELNET ~ FTP ~ HTTP ~ NNTP ~ IMAP - POP -~ SMTP - IRC -
LDAPX @MW € > A X HESSL/TLSIR A9 B EE R > Bt
SSL/TLS& i T B LB R BE BLkY -

A3t I #SSL/TLSe R A%t — B S A R ey B i 4
BH o AR R BRI BB BAHENRL S -



2. B B

21. EHFZHE

EHRELTARRBE HEUWEALBAFHBAE TR L
TEATER -

Plaintext [ > |Ciphertext

iy

i1
Plaintext <= [Ciphertext

. HBAFHLZH%

o

Plaintext > [Ciphertext

{1
Plaintext <=7 |ciphertext

2. FHUBUEB/LZSK

B REANHBENE LA LA LRRARBRESAMR LY

DES (Data Encryption Standard) A & & Xuejia Lai & James Massey
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Fite i &) IDEA (International Data Encryption Algorithm) &4 & i
Fr3Z i &) AES (Advanced Encryption Standard ); JE##E R e E 4 4
A & Ron Rivest ~ Adi Shamir & Leonard Adleman F7 & F] 3% £ RSA
M BRAHERRA A AU BE T LR G E TR
B PR3t i 85 DSA (Digital Signature Algorithm) ; #}#% 7% /v 55 1% & b2
ERBENEIHMFTNORR NEYBU N F LA ABTEDBAR
FOMAEERRERR  AU—RERFALELSHF K RBIG R
° %o T B AT

[ 1
, A Encrypted
ession Ke) =) Jpmmmmiot? 0 ession ke

L
Plaintext l > Ciphertex{

J1
. Symmetri Encrypted
Ression K (1 ot (= [Enervpicd]
[l

Plaintext <

3. HEBAFHBUNEEEBLSKL

ICiphertex{

21 1. H BB EF R &K

2.1.1.1. DES (Data Encryption Standard)

Plaintext M(64 bits)
Ciphertext C(64 bits)
Key K(56 bits or 64 bits)



Round Function F(X, Y) : X(32 bits) and Y(48 bits)
There are 16 round in DES.
IP: initial permutation
FP: final permutation such that IP.FP = FP.IP = Identity
IP(M)=(L,, R,) = (32 bits, 32 bits)
L, ,R)=(R,,,L,, @FR,_,K,),j=1,..,15
(R, L) = (L, & FRR,, KD, R;)
F(X, Y) = PC SCE(X) & Y))

= FP(R,, L)

Plaintext

l L1=R0 R1=L0 xor (ROK1) |
K2
{ L2=Rt .. [ R2=LOxor f(RO, K1) | 4

m pe -
B R 1-)..4_1&. _..' N;

,/ P |

‘ L1s= R14 \ Uus L14xorf(R14 K15) [
é 2 Kis
| R16=L15 xor fR15,K16) |._, [ L16=R15 ..

- 1 i
T TN oz rnrmre s | — - . H
i B : SRS SRR S |

vk L s ek sk

4. The Flow Chart of DES
9



Lia Rii » Key [«
I =~
1 BEEY Y BT
NN | E-box Permutation | ., [ Leftshift | [ Left Shift |
24w WAITE s g e - |
S 8 {%m /_LE‘OT?I'DTE’B'W_'_‘
éjﬂ N\ subkey|48 {i J—Ei Permutation :
l S-boxes Substitution ] )
32 47T
L P-box Permutation l subkeys#d & %
Nr/ f function
A 4
L: Ri

5. The Description of Round in detail

One round of DES
LS, =1
LS, = jth round Left rotation

Key K(56 bits)
PC-1 (K) = (A,, B,) =(28 bits, 28 bits)
A, =LS,(A,,),j=1,...,16

B, =LS, B,,),j=1,...,16

K, =PC-2(A,B,),j=1,...,16

J

2.1.1.2. Triple DES (or DES?)

10



Encipher

{ DES )—( DES’! )—»( DES )

A4

Plaintext K, K, K; Ciphertext
A
( -1 H H T e
LDES DES DES e
Decipher

6. The Flow of Triple DES
2.1.1.3. Advanced Encryption Standard (AES)
2.1.1.3.1. AES# % %

MERBEREHREOB B2 — - B EEAFIPS(H 1 &Y
BHRIEZ RO - DES(E M FZE) £ 1977 G U.SHAAT EHh -
DESR — AR F-BAEREH - T Ao E XL Z64-LT » B Ak
TR RERL 56/t NISTREZERFEHGYLIALEE)ERAELE
WFAEDESHMDESE FIM AR AR EHWEA BIFE - RMHFLER
1993 - NITSTA#AE — T rt o FARBAL1998 4% 5 KB4 2000€
A—EAMAGFREeHIRY - DESAH A ARG E G X d 7 &KE20
FXZEEHF EFoBRERIBGER -

Bt NIST £ 1997 F A Fbiz HAES[4] - A LW BELE
AENTEY L2 NH R — B F AR BT BB FRITY
BE R 2 B RE LY FIPS - AEST 4 & &R B4XDES » %k M NIST
FA#A Triple DESAE R R ¥ 475 5K R Ak A7 4o 8978 H k(B £ B BURE
) THEXHRDFRIIEREZZFR
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1.
2.

3.
4.
5.

1.

7.

AES B R AMGER -

AES #Z—EHBHERES -

AES MR R EABARETRBE Z R o -

AES % & 77 fe 5 58 Fo 30 A8 F A3k 3

AES £ Xa) £ETHE R DELARREZENH &
(ANSI) EH BB R—BAHBZT TH4)

FHGFRZFEERENT I LB R F 4k H#7

24 (B » EE/SHAALBORR) >

2. srE ey E

3. LR E K
4.
5
6

RBfRBZEEE

. ﬁﬁ E— (EP/? #/fT»G-EJ Mok T ﬁ?—)

EiEik (AR
B (HT) FX -

42000 # 10A28 ' NIST E# €i€# Rijndael A AES-

2.1.1.3.2. Rijndael ##&3tseit

418 round 654

A& Nr-1 18 round g4k ;EHE;

Round(State, RoundKey ) {
ByteSub(State);
ShiftRow(State);
MixColumn(State);

12




AddRoundKey(State, RoundKey);
}

%% —18 round &y E Ak

FinalRound(State, RoundKey ) {
ByteSub(State) ;
ShiftRow(State) ;
AddRoundKey(State, RoundKey) ;

J

ByteSub &)

acq| @, | 4o laM[ 0.0 | 3954 S-box | ~——dbs0| 001 b(,'b 2 boalbes
a',o al,l a| a,] ‘,/4 al,J h1.0 b .1 bl,] ,LJ hl.5
0|81 (8228382495 boo|bay | D:2[Da3 Dyy|bs
830831 | 932|853 83485 Dyo| Dy |b:z2| b33 D3g|bes

7. ByteSub Transformation of AES

ShiftRow & ¥ i%

m n (o} p 10 ShHlT > m n 0
J k / Tychic shii by C1 (1)
| 1 {
| |
d e fl .. cyclic shift by G2 12)
|
|
|

|
1
cyclic shift by 3 (3}
|

8. ShiftRow Transformation of AES

13



MixColumn # k3%

a.la, |20 fa a.la b, |0 By by, |b,, |0
0.0 %o 0.3 | 9o ] 905 ® ( ) 00| Yo 03 (Y04 | s
e clXx
a ——
810814 1j y{t‘:ars ‘b?h.b\nkbﬂ bysfb,.]bs
80| %2 ay, 83 8240925 b,o] b2, b21 03[ 024 | D25
30| 2 3| %935 byo] 03,4 bys| by |bys
a, b,
J 3
9. MixColumn Transformation of AES
AddRoundKey
Byg (351 | 30y | 39y | B34 | By Ko | Koy [ Koz | Kos | Keu | Koy oy | Dy | bag | boy [ Bys | by
al 9 'I 1 al H 'l a1 4 31 s k‘ ] k( 1 kYJ kl 3 k’ 4 k! 3 b‘ 2 b' 1 b‘ i bi D! 4 b(
® =
a] b a] 1 '1 a? 1 a] 4 31 3 k7 0 kl 1 kll kl,] 14 k 3 b}ﬂ bf 1 bl 2 b? 3 b] ‘ bl 3
By |3y | &y | 313 | 4| By Kyo | Kay | Kaa | Ky | Kyy | Ksy byp [ Byy | byg | byy | bay f gy

10. AddRoundKey Operation of AES

IR 0 B —18 round #R-3F w1 B34y > ByteSub, ShiftRow,
MixColumn , AddRoundKey, 4o b A5 LASF 2] — 18 AR 40 T
]

14



Byte Sub EIEIEE EIEEE] EIEEE EIEIEE

Shift Row

Mix Column

Add Round Key L% Lé : é
bhdbd &hdhd Lbhdd

11. The data flow of AES
21.2. FHBANE R &

2.1.2.1. RSA (R. L. Rivest, A. Shamir, L. M. Adleman)

() n=p*q p A q RABEREH.
MaER—MEH ¢ M2 ged(e, (p-1)(g-1)) =1, (p-1)(g-1)=
d(n), R—BEEE$H d,d<nfm A e*d=1 (mod ®(n)).
(c) Private keys (#4 % 4 4&): d (decryption key)
(d) Public keys (2B £ 48): e (encryption key), n.
(e) Encryption (4 %): E(y) = y° (mod n).
(f) Decryption(# %) D(y) = y*(mod n).

2.1.2.2. Digital Signature Standard(DSS) FvDigital
Signature Algorithm(DSA)

NIST, 419914 i DSA.
J&F RDSA#)#5t

15



(DSA & Schnorr and ElGamal ## % &:569 % A)

p=aprime number, 512<|p|<1024and 64||p|
q = a prime factor of p-1, | q| =160
g = h®Y4 mod p, where h is a random number < p-1 s.t. h®"
mod p > 1
x = a random number < q
y =g mod p
publickey:p,q,f,y
private key : x
signing : (To sign a message M).
k : a random number < q
signature (r, s) where
r = (g* mod p) mod q
s =k'(H(M) + xr) mod q
verifying
w=s"mod q
u;=(H(M) *w) mod q
u;=(rw) mod q
v=((g""*y"*) mod p) mod q
if v=r, then the signature is verified.
Proof:
w=s" mod q=k(H(M)+xr)" mod q
u;=(H(M)*w) mod q
u2=(rw) mod q
v=((gul*yu2) mod p) mod q
=((gul*(gx)u2) mod p) mod q
=(gul+x(u2) mod p) mod q

=(g(H(M)*w) mod q + (xrw) mod q mod p) mod q
16



=(g(HM)+xr)*w mod q mod p) mod q
=(gk mod q mod p) mod q
=r (=(gk mod p) mod q)
(gk mod q mod p) mod q
=(gk+lq mod p) mod q
=(gkglq mod p) mod q

=(gk(h(p-1)/q)lq mod p) mod g
=(gk(hp-1)l mod p)mod q
=(gk mod p) mod q

2.1.3. # % & # (hash function)

2.1.3.1. £ 3% % ¥ (one-way hash function)

—BEOH#FIEHTUREAETHRENREM ML —
BA B kESHMF{Eh FPH=h - ©F ZEHFFHK

L St REATH  HEMOYAEM hYRERBE ZLH -

2. ZH3tE  HEMREM ) TEH e Eh -

3. REEEIHGER © HHETOh > REXFIMEFHM) =h -

4 ARy ER  HEMHOREM, » REXRII M ERF

H(M,)=H(M,) -
5. BGEWMATR | RIERD| —H M o MAEIFH(M )=H(M,) -
T—BEaOBERHBRLE -yt CHREEL”

AANEE” - BE—BEaeBEIBEHR LEAMA A ESNT

B TREQRZIBERARNGRES IS - 2R EER

17



EOREBETREGSEEML B2EFHEAREYREKN - —
P4 AR AR EMAEE - Ko RET SR nEBFER -

BREREF RA2EBAN  FIEAFERM, Fo—EAREIRHKY
Wh, o (BPRWM, )= h) o RiE—EE— Bk BERIEMH
ITEEFBIME B 4585 h, » K AV9E E #5 A Message Digest hereafter

o

’/;a-dding bits

Message Message Message
sub-block ! sub-block2 sub-block n
M1 M2 e Mn

<

" Compressio Compressio Compressio
Initial . . vee Hash
value #> n fur;:luon E> n fm;:;uon I:> n funcuon Ci> value
h, h,

12. REAGR G R B2 4

2.1.3.2. SHA (Secure Hash Algorithm)

SHA % & 532 Lty B AT kst Bk dMDAES M R -
FETHELAMDSEA - ETAREEREGNE Wik A —ERE
Bl & %1604 7T 49 Message Digeste SHA R R & & Fl £ £ BINISTAR 32 &
&) 11 42 2 (DSA, Digital Signature Standard ) & &5 — 2[4y » 4o [
Bl S TERAAEMEERAFENEET - WA AKEAMYEE
WEM (m=0) @ FFTFH T -

Append k padding bits : F]MDS5#4 4 85— o

18
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for Sender for Recejver
Message Received Message
Message Digest Message Digest

P
=

Private DSA Sign Digital DSA Verify Public
Key Operation Signature Operation Key

Yes - Signature Verified
or
No - Signature Verification Failed

P

13. B 1 f£DSA 3% A SHA &1k %

Append the length of M ¢ FJMDS#&) 35 8% — -

Definition and Initialization *

Definition -

1. Basic functions :
F(X,Y,Z) =(X AND Y) OR ((—X) AND Z)
G(X,Y,Z2) =XDYDZ
H(X,Y,Z) =(XAND Y) OR (X AND Z) OR (Y AND 2)
I(X,Y,Z) =X®YDBZ

2. Round functions -
Round(a,b,c,d,k,s,1){a=b+((a +Z(b,c,d)+X[k]+T1)<<s); }
Z=F» 0119

Z=G»20=1=39
19



Z=H »40=1=59
Z=1-60=1=79

Message Message Message .
Block 1 Block 2 Blockn | bad | M
M1 M2 Mn

Hash
value

Initial
value

Yvyvyyvy

\YYYYY

14. B2 SHAG L5
Initialization :

1. Initialize Chaining Variables : Z/H:E 4% #A, B, C, D, E
1A :
words; A :67452301
words, B :efcdab89
words, C :98badcfe
words, D :10325476
words;, E :c3d2elf0

2. Parameters :
20



Ti =2"%/4 =0x5a827999 » 0=<i<19
=32/4 =0x6ed9ebal » 20<i<39
=51/2/4 =0x8flbbedc » 40<i<59
= 101"%/4=0xca62c1d6 » 60<i<79
3. Duplication :
WordP=A, Q=B, R=C, S=D, V=E; /87 74114
BigBlockX; // X[0] » ---X[7914X % T & 1& %! %4 &9 Words

Algorithm:
For (int 1=0; i<=n-1; i++) { /EH H S B FEREE - £80%
L=

for (int j=0; j<=79; j++)

1f j<=15)X[j] = SubBlock i[j];

else X[jI=(X[j-31D X[j-81D X[j-14]1D X[j-16])

for (int j=0; j<=79; j++) {

int TEMP = (A <<5) + Round(a,b,c,d ,k,s,i) + E + X[j] + Tj;
E=D; D=C;C=B<<30; B=A; A=TEMP;

}

Y/ BB
4. Output message digest :

ExEHEE A B, C, D, EEME32Mx A B KA R E My
f8hm (A=A+P;B=B+Q;C=C+R;D=D+S;E=E+V;) >
B8 A A Word324E 2 4 £ — A2 5L HM#Y 1604 ;uMessage Digest

o

2.1.3.3. SHA-1

21



SHA-1 % # # PR SHA ££ 35 %, X[16..79] 8 2 8% » hu_E<<1#yshift$ &
v B A X[I=(X[-3]D X[-81D X[j-14] B X[j-16]) << 1 -

2.1.4. Message Authentication Code (MAC)
2.1.4.1. MAC & f§

ERK EfBNZETRER AR RBE PHARTEEGY
NEA—ERETAHOZELERBRELL - NEWEH (MAC) A&
A EHGOTERERS B EREHEAMER > EEZ —EXL
SRR B LM AR AT AL 2MER E M AAEMACY BiNE L
KE TG EHRBER TGS TN - MACE @K EAFEH T4k
Rz E R RBEMERFNEE - £3b B FERZAEH AL AR
FoRREOREMAZGEE -

— xR FZMEFETHE A REHMACH 4| : Cipher-MAC

» Hash-M AC#vHash-Cipher-MAC -

2.1.4.2. Cipher-MAC

Cipher-MACA — & m EH X T ABREHRE AW ERE © K
CBC# X v % ¢yDES A FIPS > s & —EMAC A& % B % A
Cipher-MAC#2 £ &4 5] F -

2.1.4.3. Hash-MAC

Hash-Mac{ R E M a8 —RBARFLERBRE —BNL A
AEAESHMEEEANEHMAC - EH| RPN > 4o R Alice 8 £ Bob

22



— B3R EMEMACE 6] & Fl 4 A AL F 4Rtk - Alicei§#:#¥Mik > B
tEE BB GRAEHEKM) » A EMEIMAC - # 1% AliceitMAC
Fu 3 B M4 Bob o B ABob4uif #b F4g Rtk » 47T £ & AMAC » M K 4o
k&) % = AMallory 8] & 4€ £ £ MAC -

— 48 Hash-MAC &) ] + % Bellare # & & HMAC - 14
Hk | Hky | M) st EREXHMAC : H) X —BIEE A RE 0 k=
k @ C AesbkAHEHAF RHEFEC > ™ H3E| % ~concatenation.
o 48t #>Cipher-MAC » & 4 — B M $YMACE £ — B s 41 69482 -
Mtz sk > & B —{BHash-MACH £ #MNMAC > e R BB
PAn e 8 A Kty 35 & 3 BPENMAC(X)=H, (H, (M)

2.1.4.4. Hash-Cipher-MAC

Hash-Cipher-MAC#a &3 A R B fo FHREHEMAC £ E (04—
ERAMEERKAOHENEERE L - HORREAKRHBRZTRH -
— 1AM EHMACT F A F R K

E (H(X))

—
.

2. E,(H,(X)
3. H(E.(X))
4

. Hpp(Ey (X))

2.2. SSLi# % =

2.2.1. SSL (Secure Sockets Layer ) #8342 €

23



. SSL@MipRR—EAEMEB ERJANRLHERS T > TEE
R susrClient/Server 9B AR XA — M %xt@ey H K@W > g
RARMEE ~ fEE - RABMEH PHWME -

SSLERAW TR ERZHERERALERNBENERNZA GRS
AEFo T M BEBMME & R LR SSL Recordid 3R & £ 4
RIEE ERRAARELMBRFZRAENHE - —EZHAGENRD
& (#BSSLZ B L) Susfclient s Foserver 3% Z A8 3E M R
BRI 6 458 ik Fo BB S ¢ thkey SSLey — BT R A T T UL $H1E
— AKX ERBERFILY CREIRCTUAELEREGEAL
NeYBRLE » — B8 F B 6@ AW T T A FE£SSLB I £ 8 L3 o
SSLENBERRMRE G F DM, LF R T =M -

1. BEXAMAY > RBIERAEMEHELE BHLEETE—E

secret key > # A5 6y HAH L FH ik B T4 69445 > wwDES -

RC4% % -
2. SREET AR JEHAEA - public key 3 E#HF RAE - WwRSAH
DSS% % -

3. BERTIZHY - MEMEZXTLA —MACkey & ¥ % F# -

BB EZHTHRBAMACHEL -
SSL i 311 Zv3.08) % KX T ég eofli B 4% -

l. ZFELREAH T LM SSLEZKAREIL MRS -

2. MM TR — MR X FTUASSL v 30REEEAE
R BETURNRIREHL AR L2 B L0E
%8 -

3. 4¢P SSL&F K —H 7 ik & R4t — B £ 45 E A H dpublic key

X BAEF BT EATEEF AL c BT RBER
24



2o BR BRI AN E R AR A T L — 21
VAR EEHRE -
4. MMM F M D EB/FT HNHEFEONRPERGCPUE K -
4 %] Zpublic key 89 HE - XN EMEERE - SSLA B E 3
B FERRVENEIREEATHEE RS -
SSLEMNBBHBRAMBE > £AR—HE REFTELSAR IR &
B R A~ iAo A o SSLEEMERGE  HERSEATRIEY
MK RERBEM > HAR—MAC REABEBHERESL -
MEBRXBRAETRIL > BRI BE  EREEN - R REA
134 %] B 5 PR &clientsd o
—ESSLeg Fx % A JE ¥ %26y - SSLEB NI E 8y TR R
FAclient 3 Foserverss 49K & > AFFHEE M LR ETRA—K @
FEHEKBRETFTe) HBELRB  BEKEEHREARSR > —
RERAELAEBENRE  F_RTHRE/EIFBRESGKRE LB
SR EE RS M BT o F —fEclient 3% Rserversh i 2] — @ "
Change cipher spec | #93 A » M4 T BPAF REEF B AR | 4
Mo TEAFZHEGIKE | ; Fclient 3% HKserversp i — 18 " Change
cipher spec | A& &M TIBREENKE M2 TRHAEF
ANGREE | o E LB @R E T AL 0 client gFfoserver 3 G
# T Change cipher spec | #9385 #% A — B LKL B H A RE
—{BSSL sessionT A @4 #E X DB L ZBRATMTAREA 5
18 ] 3 Y session ° H-1Esession B9k B F L4 TFH L E -
® session&yFWEFE !

server 3% ] AHE— B EH M A aF T RAE—ETE
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1k #) % £ B g session K& -
® RE5IRIE
X509.v3[X509] 5T AR 8 » AR EH T EA THRAZ
g9 (null) -
& Rugkik:
AAR—REEERREEN  HHNRAGHBEHGEH -

® cipher spec
/\‘yﬁﬂj Hé‘l%ﬁwﬁﬁ-/i(&aDES ’nullfr# ) ‘BLKMAC

88 BE ik (WwMD5S%SHA) - CH HX HFEHE S @ey B %
%chash_size o

® Master secret

client 3% fuserversg R - F48{E Lt 48 -
® RETAHAMEA
Bl — B0 R 45 5~ —{BsessionZE FT A A R EMAY
— AR -
MiBLEEHRELSTHAE
®client 3% fuserverss &4 K B $L 3
Oclient 3% Foservers 7 MAIE B L4 &) A 5| R AR E1E
A o
®server write MAC secret
server ¥ B R4 A B HE A #secret £ AMAC &

k" /9 k
®client write MAC secret
client 3 A R A Tk B A\ #secret £ AMACE

AR -
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®server write key

server ¥ R A B v F thkey 0 IR A&clientAl R

AR E tgkey ©
@®client write key

client 3% B R & & Ao % thkey > T8 Eserverss A R
#RIE ekey ©

0Nkt e §

% — 48 F #£ CBC#4block cipherik A 2] > — 414619
¥ (IV) &% —Ekeyfrss - B8R & &8 £MSSL
B EREMNUY > REBEEE (record) #E X
£ (block) €# %8 UBET—EHERGKEMLER

® /7 71| 5% 4%
4B B MK AE IR TE BB 89 P 5] 3 R A B R
BETHERREHEETR - F -y EH KRR —E "
Change cipher spec | 3R.& » EFEFFIRBEHKAT
s B3k SR — 64 L 3 B RAE 6N TR Ty
R H RS - [7.8]

22.2.SSL ZEARMERTE

SSL 732 i@ i R A 42 18 345 W 3 I X AR E 38 Z AT AT L e th
W EBBNYE > ERAEOREALTHGERA RERRE

session Uk B &4 ZHE £ $ A SSLAE B M LA E > MSSLAE
3% I K A& ££SSL Record#y £ & i&4F - % —fESSL client 3%#e server
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WE—REW PBLRAR E—BRRBTHBRA EFRERE
Bmey R E R~ BN ESF Apublic-keyt BRI RAEA £ F o
BHRE  BEBEBALTIEARB I FESY  TOXHEANE

client 3% 3i% 3 —18 " Client hello | #53.8 » 3L ] &yserver 3% &
= & —18 "Serverhello ; #9308 » FRIM EH £ — SR > TMERL
# % 82 7 - 1218 " Client hello  #o " Server hello | . & & B & 3£ 31 client
foserver Fl 2289 & » " Client hello | #o " Server hello | &% 3
TR M B L MARAK > session ID ~ AR A EHEE )
FoR4EeF ik L H > HEERILEA A RE £ Fo Likkeydy -

Hello3fl 8 &9 3% th 14 > 4o RWF BB Ay Eserver 3% F £ & HAE
2Kt H kwREEEE» "Server key exchange | & &4 F %
H oo fR4userver 3% TAERE A © CAH & & Kclient 35% 1 —BRE
WE - ABATRRCEEFTHEENESR & -

3 fserver ¥ i # —18 " Server hello done | #9368 RIETEIE
WE P eHelloM BB RCLEBTART « A Rserver it & ¥4+
client 3% &5 = J& - {8 koservers €48 # # — 18 [ Certificate request | #)
3L > server 3% € © & —18 I Certificate | 33 2 & — 18 " No certificate
| %4 . TClient key exchange | IR AEBIFEE L - BERIKA
% 444 " Client hello ; #v T Server hello ; R 8 A7 & 3% &9 public-key &
Bk o imserversy LEHK K — AR A X ERN AR > — @
i % T T Certificate verify | .8 €44 H A A G R T HLBVER
B R o

72 $b 8% » clientig i 3 —18 T change cipher spec | #93 .8 » i B #

—{B Cipher Speci # %] 3.4t 8 Cipher Spec ¥ ° #K 1% clientys /£ #7 49

EEFE s keyFo A E Ti# H "Finished ) & - £AEEF & » server 3%
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&% 4 © 8 2. & " Change cipher spec | 3.8 » &L T — 18445 ¥ & &%
ARAENGKBY % BLEMAFHEF LA THE B 4y "Finished |
B oodoitr ZIRBECEE R o client s foserver 3% BF T LUK 45 X 4
BERAZXGEHN FETEEEL -

’ ClientHello '
ServerHello
Certificate’
CentificateRequest®
ServerKeyExchange®
Certificate®
ClientKeyExchange
CertificateVerify*
change cipher spec
Finished
change cipher spec
Finished
Application Data Application Data

HETEEART —E ORI

15. SSL Z iR E

& client 3% Fuserver 3% & & B — 18 S AT #session R FHEH —
1B €, 474 g session » M EF R aYBR L T -

server 3% i session ID#R i % — 18 " Client Hello | 2.8 » R & # £k
#) o $Rifserver 3% &4k & thsession IDA B 48 74 » ko F48 #4935 - server
3 g L iEflsession KRBT X EMRI—EEL > L FRAMEF
session ID# 18 3£ & — {8 Server Hello 3R 8 - #£ 3585 > client 3% foserver
3% &R 54 48 1% 4 — 18" Change cipher spec 3.8 » #A 4% 4 3 % # " Finished
JHE - —EEMEIRLHBETLERTAK ° client sFoserver
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TR RIREAZX Y EH > Bivsession IDRF A4 » 2T
& — 18 # #session » server 3 € & 4 — 18 #7 dysession ID » i B 18
SSL#&jgclient 3 Fuserver gk &84T — 18 7% £ 89 T 1218 M iH £ 842 -
FRBLHER BT BT

CLIENT SERVER

ClientHello

ServerHello
change cipher spec

Finished
change cipher spec
Finished
Application Data Application Data

16. SSL EMEZEREZE

SSL Z 83  X/7 & XHZHNE

f b — RV E) B TR E AW T 82 A RMREANKH
BEBBEPAHAIBGNE

(1)Client hello 3.4 :

®client_version

®random (clienthello random)
®session_id

@®cipher_suites
®compression_methods

(2)Server hello .4 :
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®server_version

®random (serverhello.random)
®session_id

®cipher_suite
®compression_method

(3)Server certificate & :
®certificate list
(4)Certificate Request 3 &
®ccrtificate types
®ccrtificate authorities
(5)ServerKeyExchange # & :
®params
®signed_params
®md5 hash
®sha hash
(6)Client Certificate # & :
®ccrtificate list
(T)ClientKeyExchange 3.8 :
®cxchange keys
(8)CertificateVerify 38 :
@signature
(9)Finished M & :
®md5_hash
®sha hash
EAASSLE 2 &9 & M & & TR & ¥ 698 % M5B SSL Recordid
Wi EHR P2 —  FEB AW A REE G Esession shR2B M -

EHRMEAARLXIESSLRecordib B - Z B NPT BEHAME
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#& F % " Hello_requests ; ~ T Client_hello ; ~ Server hello, -~ T
Certificate ; ~ [ Server_key exchange ; - [ Certificate request , ~
Server_hello_done ; ~ T Certificate_verify ; ~ [ Client_key exchange
o ~ "Finished | - MmiZdb T RBIAWP TR EHMELBRB—F
BAF 0 AARE BEARE G FRAT R4 i% o
FTaHBITHGSAE — FTELALGEEL -
(1) Hello ® &
Hello & & A R X #&client 3% fuserver 3% &R 24 7
' & —{E ¥ ysession B4 0 BEETF L - BEFE - FoEE
EERE AL > BA8CipherSpecE B kL AR EMEE WM
8. - Hello .8 A &-client 3% & Helloz & Fuserver 3% &5 Hello
WE o BRMDHREE
Client s%#yHelloR & &6 T AT R M4 -
®client_version
client 3% 8 & M A — pR A &9 B 3 T R 8 3
o 3E ¥ & clients® AT A8 X % &9 SR MR A BB E
RAEAE 302 B R A YRR A ©
®Random
—1fBdaclient 3% & £ H R ILBE M 44
®Session_id
Client 3% 48 £4# A #R1{Bsession ID R 4 A i@ A
918 45 Jo B 7% K session idHk ey B KB EHE A B
MOREFHNE  EHRUTHRRAEY -
®(Cipher_suites

i &client SRATRE XL EHB T x7 & > ™
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Fae g HE 5 o KR AR Mclient 3% 89164 0 B
session_idZ B R A EE( AR EEHNESL
BEHER)  BEGERE DA ESF Rsession
B ERHT k& -
®Compression_methods

ER&client SMAFAERB R E F L FlHdL i
B BHEF Y o B hosession idiE — MR A T
8 & — X & &8 /R Ksession 8B4 ik -

Server 3% #Hello: & &8 T ST AW+

@secrver_version

EAEMAL 4% € 77 A client 34 T client hello |
M T AT X IE 8 F AR Foserver AR IR B MR S
PR o RABFEAI0RAK
®Random
AL E & Eserver AT E AN LB
— Z & REHclient A7 & A RAELEAHE -
®Session_id
i R i 18 i 4 session B9 £ W oo B %o
ClientHello.session_idR & % &) » server 3 if g #1&
{Bisession #ysession IDF| & F Heif i —MEABFF 4 -
B 4o 3% Bl 48 15 6 > server g & EME T —HMahiE
& > 3 B4p B iEME ¥ tm e session Jk AE 0 server 3%
B & EE—{ERkclient 3ATRLAAEME - BT
T — 18 E ML A ey sessioniB A ¥E ] & o) 3w AF
¥ giEN AP finished  ME AL - FRE
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BEMAL G R —ER — e RIETEREH

& 4 - Server ¥ € B /& — 18 % #Ysession_id R 45 77
BENFREKEMNEA -

®Cipher suite
Server 3% € #¢ ClientHello.cipher_suites ¥ $k &

s

— B EEF ERER  § 2 EE —Hsessiond} » &

AR AL & 4% A7 4% B #session &9k AEE o

®Compression_method
Server 3% € #¢ ClientHello.compression_method

b HE— BB FERER > % 3 —{Esession
B o BB € 1R 7E 4% B #session #AKREAE o

Server certificate# &
W shserver M FAEEE ©

aiy axl

(2
{4 —{Blserver 3% E &£

Server hello 384 3. %] # 3 & # " Certificate , 3.8 > 18
M Certificate | M EH X LB B LT/ ETHELY

Fl #6847 X A 4 & client 3% & = 8 — 18 [ Certificate request

G B -
EERLECSTUATHHH
®certificate list
A —EX509.v3EF e —BFF > EAMU
BEAESVESESRIT] KRR TA AR

wds (CA) -
Server key exchange# &
koA B REHE  ARAAR
) » & Al Fortezza/DMS R % X #4569 8 F ik > server 3%

277 22

3 (4wDSS #E

. oasad

€)
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#. &% # T Server key exchange | #93R & -
EEALECETRATHHHut:
®Params
Server 3% &5 X%y 58 -
®Signed params
— B4R #% 48 Bl params#yhashfg - 3 B R A F 3
fBhash AR F -
O®Md5 hash
MD5 ( ClientHello.random +
ServerHello.random + ServerParams ) -

®Sha hash

SHA( ClientHello.random + ServerHello.random
+ ServerParams) °
(4) Certificate request3f &
W RESBETHEHEE L —BIERf0 L thserver 3%
o LA & Kclient 3% —EE -
BEREECST AT MM
®ccrtificate_types
EEMARF ERAMEHHEEEYFI €
AR Bserver 3% 44 i RIBFHEF &Y o
®( ertificate authorities
BRAABEFC (CA) THZXHEFFT -
(5) Server hello done#f &
Server %€ i% % 4918  Server hello done | TR & RF57 7
Server hello jfuig MR & 894 R £3E & b & 7% > server 3%
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(6)

(7

®

®)

e EHclients gy = & o 3% %] [ Server hello done | &
#% - client 3% % ZrERserver s EART A » £ A
FServerhello | A EXTHSLH °
Client certificate3f, &
1 & Al B)server 3% 1% 2R &) T Server hello done | 3 &
# > clients# 5k it 693 8 0 M8 2 A feserver 3 & K —
BB A G d 0 B F BA6EH - client 3% E%E
t —18 'No certificate | 8938 R E 4 - FALBR AL HME
' fBR4o sk 8 Fclient 3% 89 W EF > server 3% 7T M E & — 18
" Fatal handshake failure | %4 -
Client key exchange# &
EAE G BB AE KR O L E S ¢Ypublic-keyiE B L R A
o BB ERAFKIET —Esession B9k EF > &8 T A
RAFEFE B S tyrecord B EEA4E
Certificate verify 3.8

nu\—

4B 6 & A R4E Zclient certificatesy F LM » o R iE
client certificate H & T &yshst » b E M EH H A KHER -
Finished 3#.&

AR L@ % IR 2 TChange cipher specs | 2 14 i
o E A ReEEkey exchange B A E B EF R
MEEMMERE —EEAERBGEREXR keyhBREME
K3 ARRTAESK  BROFERETHALIRETR
R BB BRI L AERNE S B -

SSL key 2 ¥EZRFHEL
#:.171 Fi RSA keyExchange #]-F » #2SSLi@ i< F > key Z
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BEURERZ AL -
®ClientHello $2ServerHello
BAEEASSLEBBRWB L > client g H —@ "
ClientHello | 38 R A4t LR @ MNP E > Mserver b & B % —
M'ServerHello ;| 3. 8 - server 3% Rclient sk & £ &£ — AL 2 -

struct{
Uint32 gmt_unix_time;
Opaque random_byte[28];

}Random;

gmt_unix_time - 3% H thiE 454 B #A R 65 R 0 A AR EUNIX 32
i 7oA X &A™
Random bytes - &2 SLEE £ 5 & £ 6928 v éafl

struct{

Random random,;

}ClientHello;

struct{

Random random,;

}ServerHello;

®C(Client key exchange
# & FRSA public key 2 # % KeyExchange #4;% # 7% » Client

s &4 —## (PreMasterSecret) @ puFEHEH -
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struct {
ProtocolVersion client_version,;
Opaque random[46];

} PreMasterSecret;

client_version - client 3% Ff %X 3% &9 & IR &
random - 4643 7T 48 & % #

struce {
public_key_encrypted PreMasterSecret pre_master secret;

} EncryptedPreMasterSecret;

®MasterSecret 2 3+ &
client %% pre_master _secretFi server 3% #9public key#4s 4574
Fsbserver 3% 0 server 3%y P& A ¥ &private key AZ%% > A H

3% #f 4o i@ pre_master_secert ° ¥ LA B ¥ master secert #§3tE o

Master_secert=
Md5(pre_master_secret
+SHA(‘A’+pre_master_secret
+ClientHello.random+ServerHello.random)
)+
Md5(pre_master_secret
+SHA(‘BB’+pre_master_secret
+ClientHello.random+ServerHello.random)
)+
Md5(pre_master_secret

+SHA(‘CCC’+pre_master_secret

38



+ClientHello.random+ServerHello.random)

); /4843 7T 48
NEXFH T RTEEHES

OMAC #h & 4
A T master secret % * R KTUACREAFAY
key_block » F k4o TF :

key block=
MD5(master_secret+SHA(‘A’+master_secret
+ServerHello.random+ClientHello.random))
+MD5(master_secret+SHA(‘BB’+master_secret
+ServerHello.random+ClientHello.random))
+MD5(master_secret+SHA(‘CCC’+master_secret

+ServerHello.random+ClientHello.random))

/A %39 Ak

Key block - #&RE» AT RAMEIS > EFEENL
key block ¢ 2 A AWM TAMUSRE T EAIEHER

client MAC_write_secret[CipherSpec.hash_size] //MDS5
Flofrtéa

server MAC_write_secret[CipherSpec.hash_size] //MDS5
Flofxtia

client_write_key[CipherSpec.key material] //DES % 84x
o :h
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server_write_key[CipherSpec.key material] /DES % 84
L
client_write_IV[CipherSpec.IV_size] /DES % 8 4{& 7t
4
server_write_[V[CipherSpec.IV_size] /DES %8 4 t48
K T Eifisecret 1% - client 3% & server 3% % =] L %0i¥ 4o &,
EMAC :

MAC=hash(MAC_write_secret + pad_2
+hash(MAC_write_secret + pad 1 + seq num
+ legnth + content));

pad_1- %4 AMDS » £ &+ X 236" & F48K -
pad 2- F{ERAMDS » £A+N#M 2 5c"F F48K -
seq_num - B L B4R 7I5E4S o
length- @RGENEZHKE (R axmBEM) -
R X R AN @ Ly EH
K TMAC# » 4o £ % A stream-cipher R{%i% > AR B4 F :

stream-cipher struct{
opaque content[SSLCompressed.length];
opaque MAC[CipherSpec.hash_size];
} GenericStreamCipher;
KB LEFERF > — & B SSLin i 89 X447 & 7R

[+]

struct {
ContentType type;

ProtocolVersion version;
40



uint16 length;
select (CipherSpec.cipher_type) {
case stream: GenericStreamCipher;
case block: GenericBlockCipher;
} fragment;
} SSLCiphertext;

type - 4% B SSLCompressed.type i & -
versoin - 41Xk B8 SSLCompressed.versionf & °
length - 4 B SSLCiphertext.fragment & -
SSL =2tk 31 3
J£ 35 — 80 #4171 FA RSA public key &4 #:%% 7 RIEHSSLiE I &
B C o HEARRER B HHES 8 %4 - ££RSA public key#y F 5%
&% » Fpublic key# 2% &9 E 4T LAF private key & #2 5] » M A private
key 485 &) 4 2 4E A public key RS > T @R FI% R EAESSLEY
EAE
® A public key &% 4 F ik RAFE
4£3E £133] A % ACaryfuDiana- [something]key #% 5% fikey &R fo
#% % something e f& 4o Cary #8 £ 3% #%Diana>Diana ¥ I % public key &
private key ° kki#§public key %4 Cary (3fbaF LR ENE) » Kk
Cary % 4 —183 8 #Diana :
C->D random-message
Diana ¥ 2|74 > F B T &yprivate keyi% sl 8w F B L &
Cary °
D->C [random-message] Diana’s-private-key
Cary Yt ®|42 » iDiana Z A7i% % 4 8gpublic key H53R 8 42 B

41



» Bk Z ATi2#Diana &9 B th#k » do RABE) 693 0 BT M40

& #iDianai@ i 0 A4 A Sk 408 Diana &yprivate key @ Af 1A

BEATCRMmECary e E » REHELCary o
o MBEF

EERL@ATHR > o RA A L1488 Diana - 477 LA B Diana i#
#Caryty . B » 1244 #0284 sk 8 k{845 Diana - A7 2ADianas 4% 2 3t
BEH—WMENE %BEHKBESLCay BALBEREREHHKRER
REBERE AR EBRREBENRLE BRELLEEFERNEAN
% MFRAREHSS  Disnal e A AR A T > HBLABMEES
EE -

K i#@Diana f£Cary ZRGMEFTHL » FEAF LR R A A
FCarytyME R 2 B ARG ZNTUAA TR L RKCary BH -
FiADiana Z# B THE —KMNE REWFREL S RAFERS
Fit LA AP B R B RE M B A

C->DHi, are you Diana?

D->CCary, this is Diana

[digest(Cary, this is Diana)]Diana’s-private-key

f£ L ®EMW A P 0 Diana & sk ¢ " Cary, this is Diana | 35
FHREALE wEBEL LKL HME > Cary | B4 T 2448 5 337
& % #iDiana @ > @Dianaff R AEENE LR L > R FEFR
FEHARTA -
®:% 4 public key # ¥ %

Diana 4o 7] j3bi% i & T #ypublic key R?EMAREA T &

C->DHi
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D->CHj, I am Diana, Diana’s-public-key

C->Dprove 1t

D->CHj, this 1s Diana

[digest(Hi, this is Diana)]Diana’s-private-key
fFimAE AR £ LBBETY > AL T B 8 T A Diana
» A & 1R & public key Fvprivate key » 4R =] LA Cary3g 4% & Diana » it

4% B T.egpublic key % H o AREKIBIB W £ 847 > Cary E R € HH
REMBRE ) -

A TARERIRE - SSL3|i# T3 (CA Certificate Authority ) #9
BA ) — B EEeg (Certificate) F F@AME RS -

W 4 bR EAN B LR

WL SRR3R BA T AR

W3 45 4f £ dypublic key

WEF R 2 A

E B RIEIE A X A AT & typrivate keyR o % - f B8 AR AF
S35 474 ehpublic key > PRUAE A LIRBHE - T UHEREAAE
#Diana » 4o EDiana4F 47 1% /7 B T &yprivate key > i@ 691852 % 1%
BLEET G

C->DHi

D->CHi, I am Diana, Diana’s-certificate

C->Dprove it

D->CHi, this is Diana

[digest(Hi, this is Diana)]Diana’s-private-key

RACary WEBREHE  TUAREREER  HRFERAE

¥ % & F ADiana » #£#1% ° 12 4815 i B public key A DianaffigE A
» K44 & KDiana %% &4y > Diana # &4 LAFiE » BL—M AR E -
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Hu 5 3% #5Cary » Cary & #] A Diana#ypublic key #2542 # 8B Diana &8
WL kb T A Cary T 8 ¥ H # K % Diana -
O IR RS AL
—BCary 243 TDiana > b3 T U#EE — KM E > MTNE
2 A Diana ] LAARE] -
C->D[secret]Diana’s-public-key
4o % & 4o0i8 Cary %4+ 4 Diana » 4 JE 4 Diana #yprivate key »
FREM LB AR AT E A ABRBREFE FHME » T RfELHE
Cary i 74+ #Diana » A7 I X #4% sh ey 55 5 4 Z public key %45 F
8B RIEE 0 wRCary A1§i% 5 —ekey #Diana v FFiEfekeyit
TIREMHAER wE F % (DES ~RC4 -~ IDEA) #key T -
B &Cary & 4 iZ{A#: ¥ %4 Diana A7 kb 4oid b4 % > MDiana
A private key T LRI MERE T Tood SERE - ARl
s EEMES,  HWTUAMSHBHUFHREE L LEREFERMY
HEMER > TEAABLEBEZGHE R T
C->DHi
D->CHi, I am Diana, Diana’s-certificate
C->Dprove it
D->CHi, this is Diana
[digest(Hi, this is Diana)]Diana’s-private-key
C->Dok, Diana, here is a secret
[secret]Diana’s-public-key
D->C[some message]secret-key
Z Msecret-key E B £ £ AAHE B R EofTERE > T LA#
B R &AL E H & Msecret-key o

OMACH) & A
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HABRELCEBERREN T TN FBOA TR HA
B8 o flhosb & fECary FuDiana PRI EMEARE T UER A
THMELHT  ERMFGF L THING B @M - B
b A B Tom > #AE T &@flF

C->THi
T->DHi

D->THi, I am Diana, Diana’s-certificate

T->CHi, I am Diana, Diana’s-certificate

C->Tprove it
T->Dprove it

D->THij, this is Diana

[digest(Hi, this is Diana)]Diana’s-private-key
T->CHi, this is Diana

[digest(Hi, this is Diana)]Diana’s-private-key

C->Tok, Diana, here is a secret
[secret]Diana’s-public-key
T->Dok, Diana, here is a secret

[secret]Diana’s-public-key

D->T[some message]secret-key

T->CGarble([some message]secret-key)

Tom 1Rk % ATEME > H BB F% B FRAF AR T A
> B B FCary C4&134EDiana > A7 ALABIE B 93N E > M R 4o
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SSLE#ASKMERB S HRERFO LA LB B i
R A BB S HRERE AR RERERAF G4 MiEsiE
() G I BREIRFS R R A RER AN E ~ EEE LB EH Sy -
W ERERAAESE 0 B ATA 1S A AESSLa 32 4 #4694 Smart Cardgt
ERHERES X o BERERHEALXS09E L T £ = HERE
o ik F e

2.3.1.1. 5 5R%E

EEOREREAT  ATEOHENELBRE AT EHE
#T,» Adtimestamp ~ R, * AFTZ A &nonce ~ 1, » R TRBEETRNLE
1BELB- M,  AZBELBREETR > ATHRELE  BEARE
B G ABA M &&1ENE ~ AsgnData > #1469 EH] A A8y FL
ELamagE-A ¥ T 2@ & F A 4 timestamp# B ] $1318 87 64
R R AAMMAEAMET  MAZEHFAR HAEXMERNEE
H— o BUOKBEAREAREG AT M AsgnDatagy E# M - BT
RRBOLARETHAZL AT RETHTFH ERRLAT 6%
BRI RER MME L EEAE SERETAALBRAMM,
» BITAAT RREXLBH AR -

TR M, sgnData ’

17. X.5098 G825
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HLEHH > #ATom RedTREFEAGRE > LEBEZHETR
B 4Cary » 12 RAR AR T AR 4 AP Fa] 69 18 3R, -

ATHREEHNYFEHEL > Cary #vDiana 835 & —EM LR
%55 (MAC Message Authentication Code) » MAC 2 — & &4 &
HEMHEHAARERTELER T

MAC:= Digest(some message, secret)

B A Tom K 403 1% & S ey secret » A B4 8k 3+ B E 5k )
Digest{s > # £Tom {2 & & HAME » RYGRETLERMAL B A
Digest & B HIEF B A - AMDS R A4{84]F > Cary FvDiana %% &
*heF 6,4 — 181284 L MACHE » Tom 5 ¥ EEMACH # & L4 F
Eit- BET P F

C->DHi

D->CHij, I am Diana, Diana’s-certificate

C->Dprove it

D->CHi, this is Diana

[digest(Hi, this is Diana)]Diana’s-private-key

C->Dok, Diana, here is a secret

[secret]Diana’s-public-key
[some message, MACl]secret-key

TomBRARMBT > BABKATUAX X FEFHRL  F&

MACH 3t E st 38 H T » Cary 3 &Diana # 3 R E#EHMAC &

B TS L PRTER o
2.3. B AT RIEH]

23.1. 8
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- 23.12. % GEE

YEoRERTEOREHAFEZLBYENR RS TBERALAH
#FWM» L 6,4 77T, Béytimestamp ~ R, * BFF & 4 #4nonce ~ R, » A
ZATFif§ % enonce ~ 1, 0 AT EETRAEMEELA M, BEE
BEAABRFEER  ATRELY  SEARETRNTAAH L H LS
Y ho % ~ RsgnData > SR AAREF ABHILA SBFIENRTE
' AR EIBHBRES BT SREOREBAEMY—H AR BS THR
HERGR, P REREMAFMELMR, - BORERE T RET T LU
DABREHRLO G LEBLRBRELHTHRERTR -

A{T,.R,,1,,M,,sgn Data}

° B{T,,R,,I,,R,,M,,sgn Data e

18. X.5094 ¢ By 3542

23.13. =mEE

ZEHRERTEAREAHEZAETRS > B TADELBYE R
» BEAFTMEELLSEBAEBRAR, 0 TIREBKRRR R FHEMB
FrAEiAE R AR EHAAKHTURALEREZ MM AF R SLeiF
HTF o
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A{T,,R,,I,,M,,sgn Data}

19. X.509= 4 5% 42 5
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ClientCryptographicParametersi% 4 — {8lrandom(clienthello.random) -
3 B & Server 3% f& ServerCryptographicParameters i # — 18
radom(serverhello.random) - i /& & & 4% A #) Timestamp #v B &)
Timestamp > #&x Pk FE AR EXREAEGRELH A -

3.1.2. ARy SSLEEB AP

B TH/iSSLer s G E ek » KT E 145 ESSLIH £ b2
H B —socket®B 91 F&ip € - Hip 2L TH :

,/ Client J ( Server I

Negotiation Pha:e:E x »
& e . ’ Request |

" 2
| Random Number, TimeStamyp |

»
"] Random Number. TimeStamp |

4
A

| Cipher Suite |

'Y
'l

Cipher Suite |

il

' i
| :
] ]
l !
i :
; !
i |
5 i
i |
| - \
: ] Cetificate |
! |
1 1
| !
i {
! !
E !
= s
] [}
: |
1 1]
1 ]
'

N
y

I Cetificate

| Server Key Exchange [

| Client Key Exchange I

il

[ Finish I \
= Y Finish
Application Phase

21. B G RAEASSLEERRIBE
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3. Authenticated Telnet
31.2%CR# SSL ZEFHIPZE

3.1.1. SSL. Z 3# @ Mifh € &y 5225

HRIRZAH RMLAZBANEBZ W T UL ETME
SERG e SSLRR—BREARANHE  AHTL#BLTH

/ Client / Server

i Negotiation Phasi ) Request |
+ | ClientCryptographicParameters . !
i ) | ServerCrvptographicParameters | !
| ClientCertificate ) X !
i ) ’ ServerCertificate |
| PreMasterSecret ) ; !
| ’ Finished !
E Finished : |
| Application Phas i
] . J — ¥ !
| Application Data {
| 1
i l

20. SSLZ 7 @R &

fa R4 23.1. P ARE e X509 BEREFET  KIIT 4o
# A& SSL Z # @ W #H X ¥ - fE & Clent % £
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ABEASSLERB AP L RANFFBLENLEEELRAGHE
P 0 HE— ¥ Client %4 Server # .8 ¥ ¥ /v A T Random
Number fv Timestamp » i Server & & Client &y & & P &, o AL T
Random NumberfoTimestamp ° M 5 &7 sbFE 7% R 7 AR A48 B 35 4% Bt
HEn LEBLRBRBELHIORFTET N REIEaREY K
3 £ 45 bt £ R F #cAuthenticated TELNET & 4 o

3.2. #Z R #SSL MAC—NMAC

3.2.1. MACH o #

& {AVE B B UL F 4 6 F 55 H 212 DES ~ GOST ~ SAFER-K64%0
3 & K #tMDS5 ~ SHA#RIPE-MDB4 » Roe # E H A% B TR T AL
tt MAC A& MAELRR > w FRAT !

q

DES/MD5 |DES/SHA | DES/ GOST/MD5|GOST/SHA [GOST/  SAFER/  |SAFER/  [SAFER/

RIPE-MD RIPE-MD _[MDs SHA RIPE-MD

CBC 565 565 565 362 362 362 136 136 136
HMAC 18 25 22 18 25 2 18 25 22
NMAC 18 25 2 18 25 22 18 25 2
Ey(H(X)) 18 25 22 18 25 22 18 25 2
Ex(He (X)) 18 25 22 18 25 22 18 25 22
H(E(X)) 583 590 587 380 387 384 154 161 158
He(E(X)) 583 590 587 380 387 384 154 161 158

22. £BMACH L R (K2 —18 | Mbit &3 & /£ F 4 ZDEC
3000; E {2 1/100055)

'ﬁﬂ rﬂFlgure 22#&.&&7&% ’ ’&—.@%%z’fﬁﬁﬁiﬁﬂgﬁﬁéﬁ
Cipher-MAC #v Hash-Cihper-MACs tb 48y Fi:12R % -
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£ — 8w FE EE KB MM ALY HashMACs #Fo
Hash-Cipher-MACs REE8F B EH(HRERKAMEMT) - 55
Hash-MACs &y &2RE x4 R ARG MF R B BR  RIHE
34 Rk R R e R R B o E R H 69 A 2% 49 Hash-Cipher-MACs
RAE&E - £ FE(HX)) #1 BEa(Hie(X)) » HIAVELET — 82— 18
#7 ¢4 Hash-Cipher-MAC %4 -

3.2.2. Non-deterministic MAC

HEP—EHF iR AHFZATANRE T wA— 18 # #(Random
Number) > 34 R &7 B b E k693 &£ K B 6% 4 B & 78480 R
AEME—# o B THRABREGETUHAER > R DK
AL BBEANETHAEONEREEOEN ERMHFT AT —@
38 8YMACR non-deterministic » & # fi42 893 NDMAC > #1 & T 34
UARXNDMACKX)=E( R||H R X))k %% > ARE—EEZEE
B iLE - ANDMACY & R HR || X) &T R ERXe F B #% & #
{E_ °

1B BA AR B WU T A AL E £ e kFo MACX) 2R 5 3 MAC=
NDMAC(X) » 4 a3 ;A F #h 4kt

D.HMACHEFE PR EIHME R|IHR| X)
2)ie i3 R o558 h #PRIMBZREMAEAFRY
HUFHE HR|| X) v ERZFTHR || X)=hR#2 L%

323. 29MW
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ERERNEEELE  RIOREAGFT AR T I HEEHE
AMAC(X)=E, (Y)

Y=R||HR X)

r Rey kA

k:k

h:HR| X)

D&E X fo MACX) 4o r A FEFE# X & MACK)
o RRZARELE Kk C AMREREESFE FRIGBEREK
Y - YW FRRAEe# B RAMAX{2" 2%} - @R RABELE
18 & 3R Ao % /8 B 7% T 1R # 3 & #|plaintext-ciphertext# -

2).8E X ANRETREY —BE&Z6 ¢ M I BEMAEY =R
IHR || X) et B Al R i@ E 44 k > AR R
# & & — B4 EHXHMACH -

DNARAEREMEFRMOY PRMEIEMER M FF —H
MACH - Bt > &% X Fv MACX) > o R{E A &35 R #
RIS  HAREFRRABRERE] D —ERLEX T UL
HR’ || X)=H(R || X)7MACX’)=MAC(X) - EE L ' ko R 3%
BB EEHE  MACX)Z —EEEHX GMACH K F
X" |

4)BrEMERBERZRAERS  NRHEIHRBIES & — 18R
B BEIRR 0 AX Fo Xo RHBERE&ME/ERAER —1E
#AERBHOTHF A BREIHE -HR| XD)F— 2 ¢4
HHR || X2) « Bk » X;88 MAC R—Z & Xp4 5 6MACs -

S5)EriEARIBREGY  LRHAR B —EREFIHAY

HE —EAXXEFHX)>=YRE TS ERXHN—EANEZ
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ZFRALET X F1 MACKX) R —EREANRRE# - 32
BATRHGREIBETRRY -

WRANREFFROEERNEREEORELE  BEMIEH
MAC FikRZEH - AMANREBEZ T URELHE - NMZHR#®
Al known/chosen text X # XA EEERWEFEE L > ALK 4
ERBENEFRE LN G(TRHORAREE) H—F B> oo RE
B EREELBAESBEFTHR Y NEEATHRRIBE
448 o ERNAZE L F 18 L 8 (meet-in-the-middle-attack) : A% H &
St ELp A —Ee R WA X A 2ETa ) R 2% Bt
& R||HR || X) - AR AH AT SHAEH ALY MACR
Fo 2 AR RIS R BAAILS - o R~ TEREHSH
BAETRRRBEANORESSE Bt ATHETELE  FLEE
— B H SMUFERR fE R RAREH RO LK
i 7t (random bits) °

R ey b # M6y  ikFo Ed(H(X))FeEx(Hi (X)) #9MAC(# F& 47
RAXKE)  HR2ERR > BHEX)ERHOA SR AERZ 586
CHRMAFT EEHRS - BE(HeX)Fo £ T 5 F RS
ERECLEBRYRIELE 2RO FTEATH 0 - HHAERR > &
e ke B A mA—BiLEEZMACRE — % 8 F & — MBS
BALBAEA BTRANBREREAFBNERNWERE L ARMAOT
EP o ABMEABSWREREAKEIRR VG Bk £RE
RO EHE e EHRENG > BRIGFTENARAHREY -

MACA 4 9 %S4 T

Stepl. #L#Z 4 # & £ REILHER R,

Step2. R; R, #3eM#4 & R || M| R,
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Step3. R, || M || R, &:i&SHA-1R& 4

Stepd. B AT 1y2 47t ASHA-IR, || M || Ry)

Step5. #2R; R; #4 & R, || ASHA-IR, [[M[|R;) || R,

Step6. R, || ASHA-1R; [ M[|R; ) [| Ry 3 k @i % & B ikt

72 5]MAC
L mBREERAGEBHREE  FAHL
MACER3E & H B4 T -

Stepl. MAC 1A k BB E FE E A2 1417 3
R, [ ASHA-IR; | M || Rz2) || R

Step2. R || ASHA-1(R; | M || Ry) || R, i&iB3E£ #7453 %IR, * R,
# ASHA-1(R; | M || Ry)

Step3. R, » R,#M#EA AR, || M || R,

Step4. R, || M || Ry i&SHA-152 A SHA-1()#4 43 %)
ASHA-I(R; | M || Ry)

Step5. #% % BE281 5 B443 5] 9 ASHA-I(R, || M || Ryt — @tk ¥
Bp o BR 3sMACH) FE# 14

MACH) & £ SLEEH BB T H *
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k

R | ASHA=Y(R | M| R;) | R JJE
1 1 2 2 y MAC

I,; the block size of AEA, pre-determined

ASHA-1(): to get the fird,/2 bits of the SHA-1's result.

RG: random number generator, to generate random numbers with length equal to],/4.
AEA: to encrypt message with pre-determined block size and the shared key.

MAC —

ASHA-I(R [ M| R,)

»Valid

[AET Ry I ASHA=1(R, | M || R;) 1R,

»[nvalid

|, the block size of AEA, pre-determined.

ASHA-1() - to get the fird,/2 bits of the SHA-1's result.

Parser: to parse the data with format:R, || ASHA-1(R, | M || R,) | R,

AEA: to encrypt message with pre-determined block size and the shared key.

23. NMAC#4#
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4. SSLTelnet 1# B 5+ #

4.1. SSLTelnet Server

4.1.1. 519

SSLTelnet Server &£ UNIX T4kt ACETFFE R 2
AR % o 4# Ainetd R =F v » 3% & LAstandalone daemon# X, R ELE)

41.1.1. R E S B

YE¥ A 4k A& FreeBSD 4.7-RC
Step0. & B & root # R

Stepl. % # OpenSSL Library.

Step2. #% SSLTelnet.tar.gz 44 % &9 B 4% F A2 B

#tar xviz SSLTelnet.tar.gz
Step3. 142 Makefile

# SSLTOP % %t 2 st OpenSSL Library #4 4 & ( %o

/usr/local/openssl)
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St 140 11560 154 - PuTTY
GENERAL =Makefile

B the location where S$SLeay is installed ...

# - expect a include and lib directory under here
$SLTOP=/usr/local/openss

INSTALLTOP=$(SSLTOP)

SUBDIRS= lib telnet telnetd

# Decide if you want SOCKS support {which I haven't put into
# the ftp client yet)

#sockslib=/usr/local/lib/libsocks.a
Hsocksflags=-DUSE_SOCKS

# SunOX 4.x (Solaris 1.x)
HCC= cc -DSUNOS -DTERMCAP $(socksflags)
HLDADD: $(sockslib) ../lib/libbsd/libbsd.a -ltermcap

# Sun0S S.x (Solaris 2.x)
HCC = cc -g -DSUNOS -DSOLARIS2 -DUSE_SHADOW -DEAY_DES $(socksflags)
# the extra libbsd crud is only there for inet_aton for GCC and

Step4. AR B4ékit > REF A ¢

#make ; make install;

Step5. £ A B #E

femake install Y RBETHE CERKEREELBRE > LBEFH
BNBEMEEH  WREUFMEFIXZR  RERAAFT -

B TR G AN Jetc/ssl/certs/telnetd.pem o kv R A8 45 A A& SLTAKX
B LTH B BB ERN Jetc/ssl/certs/ KT » EHFBERL

Atelnetd.pem
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101365 168 - PuTTY
# make certificate
( cd /usr/local/openssl/certs: openssl req -new -x509 -nodes -days 365 -out tel
netd.pem -keyout telnetd.pem: 1n -5 telnetd.pem openssl x509 -noout -hash < te
lnetdipem‘.O : chmod 600 /usr/local/openssl/certs/telnetd.pem: )
Using configuration from /usr/local/openssl/openssl.cnf
Generating a 1024 bit RSA private key
b
S E

writing new private key to "telnetd.pem’

You are about to be asked to enter information that will be incorporated
into your certificate request.

What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value.

the field will be left blank.

Country Name (2 letter code) [AU]:TU

State or Prouince Name (full name) [Some-State]:Taiwan

Locality Name {eg. city} []:HsinChu

Organization Name (eg. company) [Internet Widgits Pty Ltd]:NCTU-Lab
Organizational Unit Name (eg. section) []:SSLTelnet

Common Name (eg. YOUR name) []:crypto.csie.nctu.edu.tu

Email Address [l:cryptoGerypto.csi nctu.edu. tu

1

Step6. HRAPAATHE
LSBT A A R BMPATAE telnetd > B EE R 248
$% > /usr/local/libexec/ & TF
Step7. EAEH RS ©
1).22 inetd R=f=y :
a).f5 2 /etc/services » pu A —4T
SSLTelnet 1234/tcp #SSLTelnet Server
¥ 1234 £ port 3£4E > THAREEF -
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t6d - PulTY i
1155/tep #Network Flle Rccess
1155 /udp #letwork File fcce
1167 /udp Hconference calling
1178/tcp  HSKK (kanji input)
1212/tep
1212 /udp
1222/tcp SHI RiD network
1222 /udp H#SNI RED network

1234/tcp SSLTelnet Serwer

1248/tcp

12438 /udp

1281/tep ghealthd

1281 /udp #healthd

1346/tcp  #Alta Analytics License Manager

1346 /udp HAlta Analytics License Hanager

1347/tcp #multi media conferencing

1347/udp  Hmulti media conferencing

1343/tcp  Hmulti media conferencing

13438/udp #multi media conferencing

1349/tcp #HRegistration Network Protocol

1349/udp  HRegistration Network Protocol

1350/tcp  HRegistration Network Protocol

1350/udp #HRegistration Network Protocol
equationbuilder 1351/tcp  #Digital Tool Works (MIT)

b).f& 2L /etc/inetd.conf > fe N — 4T
SSLTelnet stream tcp nowait root /usr/local/libexec/telnetd\

telnetd

stlayitony ind palTY

$FreeBSD: src/etc/inetd.conf.u 1.44 2. 14 2002/04/26 17:26.29 ume Exp
Internet serwer configuration databace
Define ~both- IPu4 and IPuE entries for dual-stack support.

To dicable a serulce. comment 1t out by prefixing the line with 'H°
To enable o ceruice remoue the "H' at the beginning of the line

TT X TRTRT T

stream tcp nowalt root /usr/libexec/ftpd ftpd -1
stream tcp nowalt root / local/libexec/ftpd ftpd -1 -a
stream  tepb nowalt root /usr/libexec/ftpd ftpd -1
SSltelnet stream tep nowait root /usr/local/libexec/telnetd telnetd
Htelnet <tream tcpb nowalit root /usr/libexec/telnetd telnetd
f#itelnet2 stream tep nowalt root /Jusr/libexec/telnetd telnetd
#shell <tream tcp nowalt root /usr/libexe hd r:hd
stream tcp6 nowalt root Jusr/libexec/rshd rhd
stream  tcp nowalt root /usr/libexec/rlogind rlogind
stream tcp6 nowalt root /usr/libexec/rlogind rlogind
Hfinger stream tcp nowalt/3/710 nobody /usr/libexec/fingerd fingerd
&finger Stroam tcpb nowalt/3/10 nobody /usr/liboxoc/?ingerd fingerd
stream tcp nowalt root /usr/libexec/rexecd rexecd
stream  tep nowalt root /' /libexec/uucpd uucpd
Stream nowalt wucenet Jusr/libexec/nntpd nntpd
S be able to print partial mailbox contents w/ biff,

C). EMELE inetd

# killall —1 inetd
2).24 stand alone # &, RELH) :
# /usr/local/libexec/telnetd
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4.1.1.2. 23N HA

PR T LA LA74R 2] &9 — 2bSSLTelnet Serverdgy £ 5b > B A — L35 4F
e FHTUER » FIHNTF ¢

-z ssl

15 & SSLTelnet Server 2 4 A SSL protocolFvClient;# & -

=Z SeCurc

% SSLTelnet ServerfoClientf#SSL protocol handshake % R 8% » 3t
B4 1k 38 48 M R 4 4SBT -

-z verify=level

35 & SSLTelnet Servers% $2Client&jcertificate gy £2 & -

0 SSLTelnet Server & € & K Client#&jcertificate °

1 SSLTelnet Server & sk Client #4 certificate 3t H #{ 32 3% » &
certificate 32 A B » MR HTHET £ -

2 SSLTelnet Server & Xk Client &4 certificate 3 B #f 3% 3% » 2
certificate3d 35 Kk B » R 4R A P BT -

-z cert=certfile

35 & Server#jcertificatefs £ -

-z key=keyfile
35 & Server ) RSA private key#g £ -

-z cipher
35 & SSLTelnet Server SSL protocol cipher suite & 4% /8 & -

4.2. SSLTelnet Client

4.2.1. ff 1
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SSLTelnet Client & B MS Visual C++ 6.0 #] A WIN32 APIFr

compile g%, * T HWin95 ~ Win98 ~ WinNT ~ Win2000fe WinXP _E 3,

ﬁo

4.2.2. %K S B&

Stepl :

f& 7% #% ¥ # 31 SSLTelnet Client 85 B 4% ( 2 C:\Program
Files\SSLTelnet & 5] ) » 4 SSL Telnet.zip2 B ANt B 4k ¥ o
SSLTelnet.zipe, 4 LA F#E £

ssltelnet.exe // SSLTelnet £ £2 &,
SSLTELNET.ini // SSLTelnet#x & #%

ttpcmn.dll // SSLTelnet common routine+§
ttpdlg.dil // SSLTelnet dialogzh 46 4%
ttpfile.dll // SSLTelnet filezf 4E 44

ttpset.dll /I SSLTelnet setupzh £ 4%
libleay32.dll // Cryptographic algorithm library
ssleay32.dll // SSLeay library

KEYBOARD E:-3::%30-%

Step2 :

HAAERANBSERTE (Bi—FT) » BERET—FHEH
TERATERM_EXTENSIONS %1 - J& F 54 Win2000 2 4] :
BRATIERLER) DN EDEMBDREEHT

L AR BB XY # LM TERATERM_EXTENSIONS
8
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VR | O]

RGO |

SR

PROCBSOR _REVISION
mmu_nmo

jl’

C \WINNT\TEMP

C \WINN TIEMP ]

=]
—

o

L |
|

ﬁﬂ(mlucol
a |

Step3 :
Ex #pssltelnet.exe @ ssltelnet.exe BF & Client i R fuServerss iE 42 &4 J&
AR -

4.2.3. 45 i R9A

T B ASSLTelnetéy £ 2. % ° A7 H & Servers# i & 69 ASCII X F
€ BT A AT #yclient aread - client areads i A —{Blscroll bar
 TEINEE Y (HATRAINMEGRE) R LBegiTs o B4
A tbscroll bar¥] 8857 & L8 F 4} -
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WARELST —EXEE  CFMeshsefotE A RIE——FF
[File] -> [New Connection] or Alt+N
248 5 — B #7r8yServer (77 &SSL sk JESSL Telnet Server) -

BETEEERAZCEATREERET  TREAFEFERSE
% 3% R AP AddressfuPort - F — 184232 A SSLAE & /5B 4F 85/
FEAE > TA3% B SSL » 4o R Serversy & £ $SSLah 45 » B A SSL telnet
B RZ A A —fetelnetif 4 -

[File] -> [Disconnect]
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sbiBE IR AT RfoServersy PHIIESE - X EARKE T > HA
1& A & %% 7 4y Message Box °

[Edit] -> [Copy] or Alt+C

A ERE Fclient aread A F R A 42453t &9 X FCopy 2| 5
PEE Y - WA E Py T TPasteN AT BARK T > XEH
sbig gz £2 X [Edit] -> [Paste] shaE REH FH o

[Edit] -> [Paste] or Alt+V

#HA A A [Edit] -> [Copy] # ¥ HEX BCopyZH & T » &
RANOERAEAXABXFEEHCopyZFREHE T > shrh B E KR ie
W BB > & MAER BN X F i 2| Serversy -

[Edit] -> [Clear screen]
hh e €M TR Mclient arecaB T B AR BB BERE

clientarea sz F # -

[Edit] -> [Clear buffer]
bl e A% scroll bar&y N & F MR » I AF 54248 £ client area s

F o

[Setup] -> [Terminal Setup]
BHTHEREZH  SHRATHIERAE
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oK Cancel |

4 g {8 Terminal SetupR % ¥ TiEFf LR FHTH M HEE
® Terminal size
TEEEIREGHATXFHTHFIE - & “Term size =
winsize” BT §RAXLBLERGTA NS €8
BT TR B E AR - & “Auto window
resize”iE T8> THRMALERAET AN RETH
FoPIBBAARNERERE  EEXREHEFTETRR
A& H BT ayscroll bar » AT A F EFosKF 8
scroll barR & 2| R B BT EH -
® Iocal echo
% local echodf 4% » 1% A & A gy A\ &9 X F 4 Clients 75
THRTHR D ERRR 0 H T A —MEASCIL code g 4
* AR Fclient areaP v h R (—XkZClientg T EF H
Rey o H— BServer e Rey - )
® Terminal ID
& B % T4k E % F SSLTelnet Client 2R 45 358 483 # A 48 o (
A VT100, VT101, VT102, VT282, VT320, VT3201% 4k

TiE )

67



[Setup] -> [Window Setup]

Window ztap ) SR ‘
(B SSL Telnct OK
—Cursor shape | I" Hide title bar Cancel
¢ Block " Hide menu bar
¢ ¥ertical line I Full color
& Horizontal li
arizantatfine M Scroll buffer: 100 lines
~Color :
& Text Attribute INormaI 'l
¢ Background Reverse
YA
BO af ] N AB(
Go | 2l
B0 4| 2

Windows Setup £ & R & AHFEF IR G E T — B M
® Title
T X ARG $9 4R (caption) BURAE A F AT E R X F -
® Cursor shape
BENETARAEERGHTHRATK A TR
B A H 4 S TR -
® Hide title bar
HERBAHRATIERALR -
® Hide menu bar
HERGHEETIRARALR
® Full color
K of4E A & & 12 42 2 BBS ¥ #] A ASNI code R B 7 #)

Serverss BF » 45 full coloriz {E:E38:E F 44 » ANSI code
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WTEFBE~ ERBETEREIHETALY -
® Scroll buffer

20 % & & scroll bar#yscroll buffer X /)~ - $5 ] Fk %) terminal
vertical size(i& ¥ %24) #]1000047 2 °
® Color

THREREGBETXF T ZNEE - —B/XF —#&F
FORBXF O OREBFTER MHXF KRBT IES
HARBMET %4 ARGBHE &4 -

3k

[Setup] -> [Font Setup]

AR RABERTRFAHF AR R AR -

[Setup] -> [Keyboard Setup]

69



—f&MmE 0 EERA F & T 44 Lk eyBackspace B > & i
~"H(CTRL+H)#|Servers » & 57 12| iR — 18 F 7T 12 & K F] 4 Server
» R F]&yservice port/f £ A ERF AL RABE - BT HEEH
2RM 0 SHEAEER BT USEHE L E B Serversy A7 & & 691218
F R 0 F| A 1818 8 58 7 1% 42 A Backspace & Delete 2k i% & 5% 44
BIRRF T -

Kevboard setup

DELby:———
"@icksp’acc,kegz | ' OK
lete key -~ | '} Cancel

<|clark.dorm-f2.nctu.edu.tw
-lwretch.twbbs.org
#Hinnbiro.twbbs.org
{meng.twbbs.org

Host listi, % 1 A 4 RGBSR B I L A TFHIREL
# 7T Ahost name =, R IP Address - £ Fl £ LT AL F LT Ak
SEREMEEIN R PR B LIRS - Auto window closeiz fE:E
BEITH M EEAERBERBRBELFESL > EREEEHE
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Rz ZFREERELFARAE IRETFeRARE P EMAMAAR
ERAEETHATERAEIETCHK S AR

[Setup] -> [Save Setup]
A LFr A [Setup] &9:EHEE A £ % /82 A Save Setup R 4%

@iai‘fié,]:?(fi ’ LA{Q‘F*;R%;;‘E_?}L?‘ E?rg%—E‘Optlon;%ﬁgi;i(
##% 77 £ SSLTELNET.INI4%) -

[Setup] -> [Restore Setup]

AHAFERERAMETREGEFRE A TRES
B4 B ey T A4E o #] A Restore Setup =] BAE#2 &, & 3% BOR 5
BB EAE

[Control] -> [Reset Terminal]
BEAEERBREN AL RALA EEFEFRERE &

[Control] -> [Are You There?]
3% i Telnet Protocol A7 & % #9Are You Therep 4 F & -

[Control] -> [Send Break]
1% H Telnet Protocol ff & & #4Breaké- 4 F &

[Window]
E18:E 8 & 5| 1B 7% SSLTelnet Client#y#8.% » & T B -
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355U Telnet- coptoSenue notuedutw VT

2SS Teinet - meng.twbbs.org YT
3558 Telnet - cryptod. csie.nctu. odu.tw VT

)«) (tiyvp0)

FreeBSD/ 1380

login: _

1 B =T A 2B hsE 142 2 £ © ¢9SSLTelnet Client# % -

1& B & F 8 4% $8 INI3% T 4 (SSLTELNET.INI)

L m BB R R4 €% S ¥ 6944 B ASSLTELNET.INI &
BEEY  SEERARK —HMEHT €ERLINEHAEZRX N —
WRARHAEE - RTRALENF A TURSE RIS EAH
ST FEHREE - HEREMURALTF -

VTPos=xx,yy I RERAHRENE

TerminalSize=xx,yy I REBXOFTHTIEK ]

TermIsWin=on or off /I B] [Setup] -> [Terminal Setup] ¥ &4term size = win sizei% 3§
AutoWinResize=on or off /I B} [Setup] -> [Terminal Setup] + &jauto window rezieif 3§
LocalEcho=on or off /I Bl [Setup] -> [Terminal Setup] ¥ #4local echoi% 58
TerminalID=terminalID /I B} [Setup] -> [Terminal Setup] ¥ #4terminal IDiE 5§
Title=string /I B) [Setup] ->[Window Setup] ¥ #ititleiE I8

CursorShape=block or vertical or horizontal
/' Bl [Setup] -> [Window Setup] ¥ #jcursor shapeif 5§

FullColor=on or off /I ) [Setup] -> [Window Setup] ¢ &4full color:% 38
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EnableScrollBuff=on or off  // [ [Setup] ->[Window Setup] ¥ &jscroll bufferi& 38
ScrollBuffSize=number // F] [Setup] -> [Window Setup] ¥ #jscroll bufferlinesi® 3§
VTColor=200,200,200,0,0,0

VTBoldColor=255,255,255,0,0,0
VTBlinkColor=255,0,0,0,0,0 // Fl [Setup] -> [Window Setup] % #jcolori€ 5

VTFont=8514fix,0,-20,136  // B} [Setup] -> [Font Setup] ¥ &font:E 5§

EnableBold=on or off // B} [Setup] -> [Font Setup] ¥ #5boldiE 17
BSKey=DEL // ] [Setup] -> [Keyboard Setup] ¥ #delif 1§
DeleteKey=on // B [Setup] -> [Keyboard Setup] ¥ #delif 1§
AutoWinClose=on or off // B [Setup]->[Host List] ¥ #5auto win closei 3§
Historylist=on or off I &% B % B #rhost list& g 5 Fo A 5

Beep=on or off Il &R T aH hbeep®

BeepOnConnect=on or off  // &4 & 214 & 5 % Hbeep &
ConfirmDisconnect=onor off // 2B H B KRB K
DelimList=$20!"#$24%&'()*+,-./:;<=>?@[\]" {|}~

Il FARF AT THH
DelimDBCS=on or off Il FABRFAAOTNTHHRAT &2DBCS
MaxBuffSize=10000 // scroll bufty & K AT # A4
NonblinkingCursor=on or off // ##% & % P

ScrollThreshold=12
SelectOnActivate=on or off
TelBin=on or off // Telnet option binary#7 ¥4 14

TelEcho=on or off // Telnet option echo£7 %5 {A.
WindowMenu=on or off / REALEE H B Windowit B BIFRBAERE
/l £ SSLTelnet Clientid, &

SSLFlag=on or off /I &% 1% FASSLRE SR
SSLCipher="ssl_cipher” /| SSLA e R s B 3% 7 ik e 7] &
SSLCipher< Al ) F &

“DES”, “RC4”, “RC2”, “IDEA”, “MD5”, “SHA”, “SSLv2”, “SSLv3”, “ALL”,
“NULL-MDS5”, “NULL-SHA”, “EXP-RC4-MD5”, “RC4-MD5”, “RC4-SHA”,
“EXP-RC2-CBC-MD5”, “IDEA-CBC-SHA”, "EXP-DES-CBC-SHA", "DES-CBC-SHA",
"DES-CBC3-SHA",.... % -

HE—-—FE2MA “” B 4w "RC2:RC4-MD5:DES-CBC3-SHA"

Host1=host name or IP address // %4 % 7 &

Host2=host name or IP address

Host3=host name or IP address
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1% 4% # SSLTelnet Server ¥ #

[ 001 Teluet - coptoScae notuedwtw VT - SIL connechon nang DES-CBC3-SHA

Fe Edk Zetwp Control Window

[SSI. Cipher: DES-CBC3-SHA,

[SSI Subject: C=TW/ST-Taiwan/[-lsinChu 0-Lab OU-8SL-telnet- ON=¢cryprod. csie. nen
L edu, tv/Fmai -cryptoeryprtod. esie. netu. edu. ty

[SSI Issuer: <C=TW-ST-Taiwan/L-HsinChus0-Lab OU=-SSL-tetnct/ON=cryptod. csie. netn.
edu, taEma T-cryptoiicryptod. esie. netn edu. ty

login: _

[Server % # SSLzj #E ]

EBSL Telet- coqptaSciie mtedute VT i o s . .,; 2100 %]

Fle Edt Zetup Control Window

FreeBSh- 1386 (cryptod. csie. nctin edu, tw ) (teypl)

login:

[Server® % #%SSL #&]
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tEmE®EE ¥ L ®iE kA F A SSLTelnet Client i& & |
SSLTelnet Servers§ &y £ &> F d@ i& 7k &£ SSLTelnet Client:E &% %]
% 3SSL&yzh

&R
€%§£JSSLTCIDC1Z Server B.3%% &

uX/£

% 3 SSLzhscyServerty £ @ o AR F IR 7| 7T L 4% i Server & &
F 8 TR

B #)SSLhsEBF » 42
7% 4 $ 31 “SSL connection”; R Z » Zi# 4 F — fxServer
FRELEISSLh 0% 0 RAA T B R B TR F $

%1% 42 Z SSLTelnet Serversf 4% > R E A ~& €5 L HRASSLA
B -FF > i3

A &4 CipherSpec » SSLTelnet Server#4certificate g subjectfuissuer ° £
BZBESHNA

® [SSL cipher: DES-CBC3-SHA]

® [SSL Subject: /C=TW/ST=Taiwan/L=HsinChu/O=Lab/

0U=SSSL-telnet/CN=crypto5.csie.nctu.edu.tw/

Email=cryptoS5.csie.nctu.edu.tw]

re‘r-
f-es-2

® [SSL issuer: /C=TW/ST=Taiwan/L=HsinChu/O=Lab/

0U=SSSL-telnet/CN=crypto5.csie.nctu.edu.tw/

Email=crypto5.csie.nctu.edu.tw]

sbinformation i 37, LA 7% ° %& 5~SSL protocol #9handshake & 5
BEEH o

% FE3E A4 AT A ServerfuClientFF & e Bt & € &
l:aly

4K F £ (
BRRAENLFAES) EMEB LR ZERRB LB G

b {3
424. BXEH
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Source Code : src.zip(Src.zip A 4 sourcefu visualc & 18 B 4%)

sb#2 X B 38 35 AMS Visual C++6.0° Workspace N X £ .4 T &
fElprojects » H ¥ — 1B B ATH Bproject* B A E A B £ T B R
BHEREHDLL) - e —EE K5 A % Eprojectty 47 & & T LA 45 55 34
AT#gcompiledy B F] 0 — ik B, B 47 69 o B R $3% 3t A DLL A A6 5T 85 0 3,
ITHRAER G FIEREROR DN BAHLERRMA G HE I E &R
M2 AREEfBloadE R#AFT -

A8 X Eeyprojectrr LA B AT ¢

ttermprofE Al 2 X R ' RERA B -

ttpemn & #H & /- & R B e

ttpdig¥t 35 3 R L -

ttpfile#d £33 § & #

tpset /& A #2 K setup ik K -

SSLTelnet Client* A £ H
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Application Entry

Windows Application
Initialization

»<_Application Idle?

YES

v

Send Buffer

Parse Buffer

Send ClipBoard

Receive Buffer

24. SSLtelnet Client X X 4B

TR T8 ABARK O HETRE  THA—E
BFRREMAHERMAMBEATHA I - E0E €A BT
AEAZTRAdekE £ Bla e Ebuffer(EA A ALY
key in#) &) Z Server » #4432 047 Fl BT g Abufferg ey F4 - & —
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A% 3¢ F & & Telnet protocol #command sequence ? 3 3 > 3#51# A £ £ #
clip board & & 434 B - & $h4T % Hiclip board 8y #2 A - sbi& B ik 7% —
F B R SR B Serversd £ & B SRR TR AN S Abuffert -
Egh BENwWELSF THTE O E XA MEEERERAIT A
ERAEXERAL -

g A Visual CH+ MFCARERZ AN FEH EARKPRGRALH
1B A MR ERE e BIBARBGAZERAEARZA T BaITH
ENRERANEEREARS T REEX X ZARRERAFH
BN BEBES REHTERERFERERFTAMEIERNEGY
B IE 24y o @ MMFC# Windowsikevent-driven#y & &8 » &5 18 B F ¥
BEREFEE > EREEXIBID 4 %% Reymessagetd » RBAEX
+ $# & 18 message & 2 F X R T H ¥ & 4 code -
BEGIN MESSAGE_MAP = END_MESSAGE_MAP ¥ 7] i T 4 (=4

X & &R ¥Z #ymessage °

BEGIN_MESSAGE_MAP(CVTWindow, CFrameWnd)
//{{AFX_MSG_MAP(CVTWindow)
ON_WM_ACTIVATE()
ON_WM_CHAR()
ON_WM_CLOSE()
ON_WM_DESTROY()
ON_WM_DROPFILES()
ON_WM_GETMINMAXINFO()
ON_WM_HSCROLLY)
ON_WM_INITMENUPOPUP()
ON_WM_KEYDOWN()

ON_WM _KEYUP()
ON_WM_KILLFOCUS()
ON_WM_LBUTTONDBLCLK()
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ON_WM_LBUTTONDOWN()
ON_WM_LBUTTONUP()

ON_WM_MBUTTONDOWN()

ON_WM_MBUTTONUP()

ON_WM_MOUSEACTIVATE()

ON_WM_MOUSEMOVE()

ON_WM_MOVE()

ON_WM_NCLBUTTONDBLCLK()
ON_WM_NCRBUTTONDOWN()

ON_WM_PAINT()

ON_WM_RBUTTONDOWN()

ON_WM_RBUTTONUP()

ON_WM_SETFOCUS()

ON_WM_SIZE()

ON_WM_SYSCHAR()

ON_WM_SYSCOLORCHANGE()

ON_WM_SYSCOMMAND()

ON_WM_SYSKEYDOWN()

ON_WM_SYSKEYUP()

ON_WM_TIMER()

ON_WM_VSCROLL()
ON_MESSAGE(WM_IME_COMPOSITION,OnIMEComposition)
ON_MESSAGE(WM_USER_ACCELCOMMAND, OnAccelCommand)
ON_MESSAGE(WM_USER_CHANGEMENU,OnChangeMenu)
ON_MESSAGE(WM_USER_CHANGETBAR,OnChangeTBar)
ON_MESSAGE(WM_USER_COMMNOTIFY,OnCommNotify)
ON_MESSAGE(WM_USER_COMMOPEN,OnCommOpen)
ON_MESSAGE(WM_USER_COMMSTART,OnCommStart)
ON_COMMAND(ID_FILE_NEWCONNECTION, OnFileNewConnection)
ON_COMMAND(ID_FILE_DISCONNECT, OnFileDisconnect)
ON_COMMAND(ID_EDIT COPY?2, OnEditCopy)
ON_COMMAND(ID_EDIT PASTE2, OnEditPaste)
ON_COMMAND(ID_EDIT CLEARSCREEN, OnEditClearScreen)
ON_COMMAND(ID_EDIT CLEARBUFFER, OnEditClearBuffer)
ON_COMMAND(ID_SETUP_TERMINAL, OnSetupTerminal)
ON_COMMAND(ID_SETUP_WINDOW, OnSetupWindow)
ON_COMMAND(ID_SETUP_FONT, OnSetupFont)
ON_COMMAND(ID_SETUP_KEYBOARD, OnSetupKeyboard)
ON_COMMAND(ID_SETUP_TCPIP, OnSetupTCPIP)
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ON_COMMAND(ID_SETUP_SAVE, OnSetupSave)
ON_COMMAND(ID_SETUP_RESTORE, OnSetupRestore)
ON_COMMAND(ID_CONTROL_RESETTERMINAL, OnControlResetTerminal)
ON_COMMAND(ID_CONTROL_AREYOUTHERE, OnControlAreYouThere)
ON_COMMAND(ID_CONTROL_SENDBREAK, OnControlSendBreak)
ON_COMMAND(ID_WINDOW_WINDOW, OnWindowWindow)
/1}YAFX_MSG_MAP

END_MESSAGE_MAP()

ABEREmessageti ) H A E * X Py~ GTH ETIRAE &
BB BEAEITHRBERZRREEALY I MHF - X
ON_WM_CHAR() &1 > &4 A H T4t E—Ei4es > X0
#7OnChar() B KM AMFCE £ ¢ &# > 24£0nChar() ¥ » X g%
oo KB B & 4 IBAL# ¢ &% #CommTextOut() » o RINIHE /9 3% &£ local
echo » A # # & #47CommTextEcho() 2R EMTE L - KA
scroll barg % — B4 -FRWA > A LD T E A #Yscroll bar » g3
#0nVScroll() » & $ M &K B¢ 89 % — 18 % #nSBCode ( A & %
scroll barZ A &S RI& > RERT—AFFEKE) > Ry
DispVScroll() iz X 3L 3| KX R R EF Y Fbuffero B HEd £

FER B o
B RGO EL T !
buffer.c /| & 32 scroll buffer# = & & 4%
clipboar.c // B E clip board & zh #E & $L 48
commlib.c // & ¥ 4835 communication#y oh AE &k LAY
keyboard.c /| R EEkeyboard #) 3 £t & S AE

ssl.c // B 3T sslézhfE ok B4
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telnet.c
ttdialog.c
ttwinmain.c
vtdisp.c
vtterm.c

% source files °

/] A5 Serversd Bk Bl 89 B & o 58 R 2
/] RIEBHIEFRAHEE RBAE

/| 38, % variablefuv flagt¥

/] % by R IR R BAE
/] VT4 3% 4 KL 5% 2 5E R B04%

& 1% A48 % B SSLTelnet Client#y #2 X 4248 6,5 Z AT AT A $2. 3

SSLTelnet Client Project

Structure

Application-handling
Program

BBRAR —REREE T RA

Message-driven
Event

Underlying
Function Program

Teraterm.cpp

Window-handling

Onidle() '

OnChar()
OnKeyDown()
OnLButtonDown()

Program
Viwin.cpp

\j

File-handling
Program
Filesys.cpp

Lt

OnVScrolk()
OnMove()
OnSize()
OnPaint()

OnFileNewConnection()
OnDisconnect()
OnEditCopy()
OnEditPaste()
OnSetupTerminal()

N

1N
N1
1N

Buffer.c

Clipboar.c

Commlib.c

Keyboard.c

Ssl.c

Telnet.c

Vtdisp.c

Viterm.c

LLLLLLLL

25. SSLtelnet Client %4 E
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BAERATREL  ERMES AL NGHEET  BIILELE
% B project ¥ &4 teraterm.cppFovtwin.cpp * K& B E R EECMEI DY
message-driven event function & & A — 18 & &A1 48 520y 24y o
# tbevent function € = = underlying tool function » Ff LA 4k B3 % 179 AF 4%
i¥ B| & B 42 M 18 & 5 2underlying tool functiond, & &£ 54 & o

S. &

ARG EVATHER T KMH BB LD/ BRE—EAY
RO e M EBATEHLETHHB T NELS EHBEN E
A4 MARBAMEERBUREB RO ¥ 64SSL ~ TLS#
Telnet ¥ 48 Bfl &9 4838 215 & » 48 M Source code 3% % # M 2CD -

AHIETFEAEREBA KRR (telnet) BB T2 2@
%4 > 324 Sniffer Prosgss #f G RSB MBI AL E LR #37
HEad SRS LARBANTLHERMEH -

82



6. 5% UK

[1] MLtz CD & H (4 R¥%H)
2] EREAHEMBRBIRFEL L EETHRER(RABNT4
BEPE ).
B] EEEHERBEMBEATHKEBETREHYITTHREN(
RBITHEEH/HEPEH) -
[4] RBIACRELHEMB EHMBIETRZBREIRE LT M 0(
R B E 12 48 5 EP5£82/3) o
[5] TRREMAAZTHBE LT @RCEB I L EER, 2M%
%.:47 #09-03-017)
[6] FTHEAMETFEMNARBATRERLITHRARERABELZESTE
WEER)
[7] $EBEBHRTERFERALPSEY BBEAE) -
Bl FHRARFERABEE T FBAARL T ERRRS (2B AHA
MEFAXRBRMEEREEBALNE) -
[9] + # 15 & % T4 (Intranet) R 8] £ (F R 85/12) -
[10] &4/ 8] 786/3/31—86/4/1542 4 KA % ~ B HF o
[11] RSB A % 484 (5% » 85/3) -
[12] BT ¥ R & (EDIFR) -
[13] EEBLLERRSBMIARARIBA LKL (FEERZER
K& » 85/6/30) -
[14] AXRERR LA, 845 THEAE & -
(151 4% ¥ 2 > BERELHEN TERARAEARBHEARE > 199549

83



A o
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4% A. Telnet 2 SSLTelnetZ 447 $1 Lh ¥

AEEAFEA Sniffer Pro R 5 #7Telnet # SSLTelnet = % & -
Sniffer Pro £ —E WA JEF ARG HE > TURA RSV @B YR EH
BE - EBEAHOEE -

TRIRIR

Server % Clients%
CPU Pentium-166 PentiumlII-1G
TR A 128M 256M
Z 5 £ X F|10M M
FE R 72 Fol
(T FreeBSD-4.7-RELEASE |Windows 2000 Professional
W+ 100M Ethernet 100M Ethernet
IP 140.113.208.125 140.113.208.142
P& AR
Server 3% Clients#
Openssl-0.9.6g src.zip
SSLTelnet.tar.gz SSLTelnet.zip
gcc30-3.0.4 Microsoft Visual C++6.0

EULATHB FERMABZL IP 45 % 4 140.113.208.142
140.113.208.125 ¥ &4 # B2 M 5 % A telnet FoSSLtelnet & /% i£
e o K% A A Sniffer Pro REAKRMEE R EAHENEYTE
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AR LERARER AN -

=

2| 8|

;f’ Siutfer - Local, Etheret (Line speed at 1003 Mbpe)
Ee . Monkor  Capture " Display Jools Database Window Help .

ol ol mlon|ds| K e =] | 2lE] 818 Qlmlo|oE S @R £

For Help, puess F1 &G 1] 2 A0 4

¥ B 7 .F Sniffer Pro E % telnet A &y3 &

Stepl. ‘X ZHIRI L &

[Capture]-> [Define Filter...]-> [Address]

Set for 2% %A Default

Address Type % % IP

Stationl %% 140.113.208.142 ( source)
Station2 %% 140.113.208.125( destination)

Dir. %4 <->(#%)
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) ah Patbml Advancedl Buffer |

Known Address:(Dragable)

I @3 Broadcast’Multicast Address
.S Address Book

(¢ Include
" Exclude

o Bi ion 2 4]
$4.40.113.208.142 =1/140.113.208.125
s T ; 1

Step2. RE ZH T
[Display]-> [Define Filter...]-> [Address]
Set for 3% %A Default

Address Type #% % IP
Stationl %% 140.113.208.142 ( source )
Station2 3% % 140.113.208.125( destination)

Dir. % & <> (#6)
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' ahjﬁfittefnl Advancedl . i : Sethngs rl:ori: R

Known Address: (Dragable) ‘

(' Include
" Exclude

ion 2 B
40.113.208.142 &)+ ®1140113.208.125
_-%—_ . .

—

[

I

!

!

(L]
4R

e

%

Step3. B 45 B: 34 3 IR ER 3 &

[_.,’:' Sniffer - Local, Ethemet {Line speed at 100 Mbps)
File emior” Capture Display Tools Database = Window Help

[l — (=g

¥ g4 ;i}_] [Defaut

Step4. 42 140.113.208.142 4% M telnet & 4 2] 140.113.208.125 &
port 23( 140.113.208.125 feport 23 1A & i #4telnetd 2R listen) 3t 47
Alogintk 3% Atest » Fa5 4123456 4R » B EEwo T

0L Telet- erptoS o aemadute V1 e A [ §
Ele Edt Setup Control Yindow

FreeBSD/1386 (cryptod. csie. nctu. edu. tw) (teypl) E]

login: test
Password:
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StepS. 4% L INBR I BARH BB

; - Crattes - Lor 2l Etheriet (Line peed at 100 Mipe)

Siatier - Liocal Bthermst (L uie speed at 10 Mbpe)

QWWMIN‘WW&

_:uL:IEL'!l_HE-Tu—ZIIEIEJ_I_IEIELL!l!J!Iﬂ@l_J_I_H

Step7. BATHEXR
R R B E P 5048 4 & 0 % B Telnet IAC# control message °
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llu-mmmm.m

o o] slou]aa] 5| W.r——_j

SmM&na
. ) :
{140.113.208. : Elharlypo-OBOD size=60 bytes
1 D={140 113 208 142} S=(140 111 PAT S

i TC De250% 5223 SYN ACK=3£72439121 SE(=41
(Wi} [140.113.208.142[140.113.208.125) C. ELherLype-OﬁOD sxze'SO bytes

i I D=[140.113.208.125] S=[2140 112

D=23 3=2505 ACK=414%2 G
4 {140.113.208.142/[140.113.208.125] : Ethertype=0800, size=60 bytes !

' D=[149 113.208 1367 S=r14) 1173 ]

| - |

i | i
.5 [140.113.208.125{[140.113.208. 0:00 00.057] 0.034.744
D;G [140.113.208.142,(240.113.208. 0:00:00 057; 0.000. 112!
1.7 |[140.113 208 125 [140.113 208. 6:00:00.058: 0 001 112

i I ;

: | I i =
4 L,—I
= B

P Destiuation poxt
Initial sequenze numb=r « 2
Heat 2apscted Sw=g nuabers
© Data otfs=t _j
¢ Reservsd Bits  Reserved t the Hex Duapd
Fleys
’ =
00000000 UD c0 26 dd Oc 9e 00 05 5d Oc 76 7f 08 00 4 \J” 777 ] vi E
00000010: nu ,n '.~; 4: i\, un Ru m ‘4 da 3c 71 40 de 5 7 (&) (737
00000020: oo £9:50°00 00 00°00.20" oz ,,.7.m...
00000030: fa w tﬁ 2’ 00 OD BZ Dl 05 b¢'.01.01 04.02 Py SUER SR

\Expert )\ Decode A Matrix \ Hoet Tabis J\ Protocol Dist._\ Statietics /
ot pms Pl & ul nr SN

Al @ AN P OSIBE O || S8 GE| B | O [ST Q| Fe | 0| @] Bs.| FEESQTUE T#i0n

3 login 2 7% H AT test &y F 4%
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NP er— EIEJQL@J_M_LJ!L@ SlelBelela) 2] o & .

Na. Soucs Addiess Summary Lm Rel Time Deka Time
17 [140.113.208.125,[1(0.113.208.1(2] DLC: Elhertype'OBDD s1ze=61 bytes 51 0:00:00.214 0.036.225
| 183 D={140 113 208 14"] S=2[140 113 iP5 .125]
i | TP "‘35’]3 :’2: “s 2435180 SEQ=414:
H T
(140.113.208.142!(140.113.208.125] bytes 60 0:00:00.353] 0.138.749
IF D= [HO 113 203 .12 5} 0 112 268 1427
TP D=3 5=2505 14mm¢h CIN=£41¢
i [140.113.200.142/[140.113.208.125){D1C. Ethertype=0800. saz 60 bytes 60 0:00:01.997! 1.644.727,
: 1P "-(140 11).203.12 SI -{NJ 113.208.142]
H 250 CK=1145262441 3EQ=2672 ;
0 20 [140.113.206.125!(140.113.2008.142] DLC: ze=60 byte 0:00:01.999: 0.001.144;
: I 208’ 1427 S=[2 |
i T ,.f‘nx';r, g 33
021 {140.113.206.142](140.113.208.225) : Eth-rtype-DBDIJ “size=60 bytes 0:00:02.095; 0.096.400:
i 1 : 4'J oe 145, T=[14] 1 !
| aCV 4146267442
i i
(3:22 {140.113.208.125[([140.113.208.142) Qze-so bytes 60 0:00:02.096: 0 000 .971;
i I H
; | |
0 23 [140.113.208.142/[140.113.208.125) 0:00:02.259: 0.162.844
1 H
|
; T !
[ 24 [140.113.208 142;{140.113.208.125] 0:00:02.271) 0.012.764
' ! I
(] 28 [140.113.208 125:[“0.113 208.142] 0:00.02.272: 0.000.960
7 Tos | [_—
i1: 26 {140.113.208.142,[146.113.2008.125} -8 y 0:00:902 373: 0.100.678
! i 3 11z ! :
i 6}:-41:5_9:444 | ‘
DiZ7 [140.113.208.125;[140.113.206.142} D ze=60 byt 60 0:00:02.37(‘1 0.001.018]
i :-[‘dJ ‘lJ ZUB 142] S=[142 |
i ACK=367243 ' |
ﬂ‘?n 1140 117 208 14211140 112 208 19€1NTEY FrhartunesNf00  «isasin hotae !sn n.0A-N2 GeAT N 1RG :1&1;_‘;‘
>
=23) TCP: —— TCP hoader —— 2]
8 e ~
Decode A Mairix A Host Table A Protocol Dist. A Statistics
For Halp, jues FL & | 2l

e 42 POSIERD

4£140.113.208.125 1% Password: 2 7% #R 2] 140.113.208.142 #7 1% &4

12345
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SEoleEeeR zl el 8l

- Len (B el Time Deokta Time {Abs.

[140.113.208.128 . . . DLC: Ethertype=0800. size=8S bytes 65 0:00:02.654] 0.032.374i

l P D= (uj 113 208.142] :’[140 113 I0E.129) [ i

| 23 250Ck SEQ=414% | i
(31 (140.113.208.142((140.113.208.125] Ethart ypa=08 60 ‘ 0:00:02.760] 0.106.768i
| 1 D=[143 113 20812 S]1 3 [140 113 268 1427 } H

i TP D23 52508 ACK=414n25245¢ VIN=r4ll i !
1:32 (140.113.208.142|[140.113.208.125]/DIC. Ethertype=0800. sxze-GU bytes 60 ! 0:00:02.901| 0.140.641'
| 1z De[1 113 203 (140 113 208 .142] i

(5 =114525245% SEQ=767¢ i

| T w |
I0:33 [1‘0111200.125?[140.113,208,1‘2] Ezheuypa-GGOO zes=60 bvtes 60 | 0:00:02‘993[] 0.097.026
N I ol l“ 208 142] Se[140 . ! :
i i TF ACK=357 g i I
1. 3¢ [140.113.208.142[140.113.208.125) C 0:00:02.998, 0.000.090
i I i
! ;(-4“,2».4#% :
| | : i
D-3S (140.113.208 125‘[1‘0,113.208.1‘2];31L Et ze=60 bytes ; 0:00:03.098; 0.09%9.896
; i |1 D= ] 1 ! :
: | iTCR e : i
i) 36 [140.113.208 142:[140.113 208.]25]‘DLL Et i 0:00:03.098; 0 000 077
i = =[140 113 H '
: i | A ‘46“5 16 i |
037 ![140 113.208 1255[14& 26260 bytes i 0:00:03 198; 0.099.933
0 38 ‘[140.113 208 142?[140 0:00:03.308; 0.110.095
0,39 '[140.113.208.125 [140. ¢ 0:00:03.408/ 0.099.903
: | ; | | :
: [ i H t
Ji <0 {[140.113.208.142/(140. | 0:00:03.59! 0189 157;
: i | H i
o | | |
mE 10140.113.208.125(140. | 0:00:03.688, 0.091.830:
| | | .
‘in irun 112 ona 142! ran ! n-nn-na el 0o nne‘_llj
»
& X)) TCP: ~——— TCP header ——— <]
N R i >l
Decode A Matrix )\ Hosl Table )\ Protocol Diet. A Statietics
ForBalp, el & 1] 2 iNE]
2 AP >TSS IBHOE || | E | B | Epw. [[Ssne Gk | 30a. | e | [GFEBES TF 1053

BT R, o telnet T+ AR L > T A 5 B9 INE] ATE AR IE

K 5 . A Sniffer Pro B % SSLtelnet {¥:£ 853
&

Stepl~3 $#2 F .4k &9 F B — 4%

Step4. f£ 140.113.208.1424% F SSLtelnet & 4 % 140.113.208.125

#port 1234( 140.113.208.125 feport 1234 pASSLtelnetd R listen)
337 Alogintk 55 A test » %5 45 & 123454k 48] 3%,
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SSL connection wsg DES-CBCA-SHA e i W e Avl_ f =151 x|

3

[SSL Cipher: DES-CBC3-SHA

[SSL Subject: /C-TW/ST=Taiwan-L-llsinChu/0-Lab/OU-SSL- telnet/CN=cryptod. csic. nctu
L edu. tw/Email-cryprofervplod. csie. netu, edu. tw )
[SSL Issuer: C-TW/ST-Taiwar/L-HsinChu/0-Lab/ OU=SSL - telnet (N=cryptod. esie. neu,
edu, twFmal l-cryproferyprod. esie.nctu, edu. ts

login: test

Password:

Step5 ~ Step6 # Ak &y F R —4%

Step7. BATEIEER

£ % 1048 43 & ¥ % 32,140.113.208.125(crypto5.csie.nctu.edu.tw) &9
B LEMEEAME @ P 4F 2 SSL handshake &4 8% - 4pik
X ¥ PR 47 89 login $2 password Fv test ¥ 12345 5 < A gt
SSLtelnet i 4376 B 7] WA iE 3|30 H AR

Fy
%|

> D02 105 [du o lis oo

J

0:00:01.044

r

dc 71 4l ’d gz 7
00

Noo

CRLR S N, PrOR,rORSDNE
b V€ adds

.nctu.edu.

02121219

31212190
od ;

PWIAIR BRI RN NN D BINI BRI B N D17

wno

: 20’5
00000230 £7.0d

Al a2 >0SIF@OQ [im_lﬁﬂ_tﬂ_ﬁ_l_@_l__li_lﬁl EE@“'IJJI
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